Applied Biosystems
Veriti™ Thermal Cycler

User Guide
Contents

Preface

How to Use This Guide .......................................................... vii
How to Obtain More Information ............................................ viii
How to Obtain Support ........................................................... viii

Safety and EMC Compliance Information

Safety Conventions Used in This Document ............................ xii
Symbols on Instruments ....................................................... xiii
Safety Labels on Instruments ............................................... xiv
General Instrument Safety .................................................... xv
Chemical Safety ................................................................. xvi
Chemical Waste Safety ....................................................... xvii
Electrical Safety ................................................................. xvii
Physical Hazard Safety ....................................................... xvii
Safety and Electromagnetic Compatibility (EMC) Standards ........ xvii

Chapter 1  System Overview

Introducing the Veriti™ Thermal Cycler ................................. 1-2
Using the Touchscreen ....................................................... 1-3
Menu Overview ................................................................. 1-6
About Run Methods ........................................................... 1-8
About Folders ................................................................. 1-15

Chapter 2  Getting Started

Installing the Veriti™ Thermal Cycler .................................... 2-2
Before You Start ............................................................... 2-2
Environmental Requirements .............................................. 2-3
Materials ........................................................................ 2-3
Unpacking the Veriti™ System .............................................. 2-3
Setting Up the Veriti™ System ............................................. 2-4
Connecting to a Network Printer .......................................... 2-5
Connecting Together Multiple Instruments .......................... 2-5
# Powering On

Powering On .......................................................... 2-6

# Setting Up the Veriti™ Thermal Cycler

Setting Up the Veriti™ Thermal Cycler .................................. 2-7

Recommended Instrument Settings ......................................... 2-7

Setting Up Instrument Security and User Accounts .................... 2-9

Adding Users .................................................................. 2-10

Setting Other Options ....................................................... 2-14

## Chapter 3 Performing a Run

Performing a Run .................................................................. 3-1

Selecting Disposables .......................................................... 3-2

Disposables for 96-Well Veriti™ Thermal Cyclers ...................... 3-2

Disposables for the 384-Well Veriti™ Thermal Cycler .................. 3-4

Disposables for the 60-Well Veriti™ Thermal Cycler ................... 3-4

Loading Samples into the Instrument ....................................... 3-5

Loading Samples in Veriti™ 96-Well Thermal Cyclers ................ 3-5

Loading Samples in the Veriti™ 384-Well Thermal Cycler ............... 3-6

Loading Samples in the Veriti™ 60-Well Thermal Cycler ............... 3-7

Creating a New Run Method .................................................. 3-8

Editing Details .................................................................... 3-10

Performing a Run .............................................................. 3-18

Monitoring a Run .................................................................. 3-21

Viewing and Printing the Run Report ....................................... 3-25

Removing the Samples from the Instrument .............................. 3-25

## Chapter 4 Troubleshooting

Troubleshooting .................................................................. 4-2

Returning an Instrument for Service ....................................... 4-3

## Chapter 5 Utilities

Utilities .............................................................................. 5-1

Using GeneAmp® PCR System 9700 Run Methods .................... 5-2

Upgrading System Firmware .................................................. 5-5

Calculating Melting Temperatures ............................................. 5-7

Viewing Instrument Statistics .................................................. 5-8

Restoring the Factory Settings ................................................ 5-8

Running the Cycle Performance Test ....................................... 5-10

Tests Using the Temperature Verification Kit ............................. 5-11

Running the Heated Cover Verification ..................................... 5-11

Running the Temperature Verification ..................................... 5-12

Running the Temperature Nonuniformity Test ......................... 5-13

TVK Recalibration ............................................................... 5-13
Chapter 6  Maintenance
Scheduled Maintenance ........................................ 6-2
As-Needed Maintenance ........................................ 6-2
Cleaning the Instrument ....................................... 6-2
Replacing Fuses .................................................. 6-4
Parts List ............................................................ 6-6

Appendix A  Instrument Specifications
System Specifications .......................................... A-2
Printer Specifications .......................................... A-3

Appendix B  Disposables
Disposables ........................................................ B-2
Other Supplies for Sample Handling ...................... B-4

Appendix C  Predefined Run Methods
Predefined Run Methods ....................................... C-2
  AmpliCycle® Seq Run Method ................................. C-2
  AmpliTaq Gold® DNA Polymerase Run Method ........ C-3
  AmpliTaq Gold® Fast PCR Run Method .................. C-3
  BigDye® Kit Fast Run Method ............................... C-4
  BigDye® Kit Standard Run Method ......................... C-4
  Fast PCR Run Method ......................................... C-5
  General PCR Run Method .................................... C-5
  LMS2 Run Method .............................................. C-6
  Time Release Run Method ................................... C-6
  Touchdown PCR Run Method ................................. C-7
  XL PCR Run Method ........................................... C-7

Index
Preface

How to Use This Guide

Purpose of This Guide
The *Applied Biosystems Veriti™ User Guide* provides information about installing, using and maintaining the Applied Biosystems Veriti Thermal Cycler.

Audience
This guide is intended for novice and experienced Veriti Thermal Cycler users who use the instrument to perform PCR.

Assumptions
This guide assumes you have knowledge of basic laboratory procedures and PCR chemistry.

Text Conventions
This guide uses the following conventions:

- **Bold** text indicates user action. For example:
  Type 0, then press **Enter** for each of the remaining fields.

- **Italic** text indicates new or important words and is also used for emphasis.
  For example:
  Before analyzing, *always* prepare fresh matrix.

- A right arrow symbol (►) separates successive commands you select from a drop-down or shortcut menu. For example:
  Select **File** ► **Open** ► **Spot Set**.
  Right-click the sample row, then select **View Filter** ► **View All Runs**.

User Attention Words
Two user attention words appear in Applied Biosystems user documentation. Each word implies a particular level of observation or action as described below:

- **Note**: Provides information that may be of interest or help but is not critical to the use of the product.

- **IMPORTANT!**: Provides information that is necessary for proper instrument operation, accurate chemistry kit use, or safe use of a chemical.

Examples of the user attention words appear below:

**Note**: The Calibrate function is also available in the Control Console.

**IMPORTANT!**: If your instrument is so configured, you need a valid user ID and password to log in.

Safety Alert Words
Safety alert words also appear in user documentation. For more information, see “Safety Alert Words” on page xii.
How to Obtain More Information

The following document is shipped with the system:

*Applied Biosystems Veriti™ Thermal Cycler Quick Reference Card* – Provides a summary of information about the thermal cycler, its installation, and accessories. It is designed to help you quickly learn to use the Veriti Thermal Cycler.

A portable document format (PDF) version of this guide is available on the *Veriti™ Thermal Cycler Documentation CD*.

**Note:** To open the user documentation on the *Veriti™ Thermal Cycler Documentation CD*, use the Adobe® Reader® software available from [www.adobe.com](http://www.adobe.com).

**Note:** For additional documentation, see “How to Obtain Support” on page viii.

Obtaining Information from the Help System

The Veriti Thermal Cycler has a Help system that describes how to use each feature of the user interface. Access the Help system by touching (Help) at the bottom right corner of the instrument touchscreen.

Send Us Your Comments

Applied Biosystems welcomes your comments and suggestions for improving its user documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

**IMPORTANT!** The e-mail address above is for submitting comments and suggestions relating only to documentation. To order documents, download PDF files, or for help with a technical question, go to [http://www.appliedbiosystems.com](http://www.appliedbiosystems.com), then click the link for Support. (See “How to Obtain Support” below).

How to Obtain Support

For the latest services and support information for all locations, go to [http://www.appliedbiosystems.com](http://www.appliedbiosystems.com), then click the link for Support.

At the Support page, you can:

- Search through frequently asked questions (FAQs)
- Submit a question directly to Technical Support
- Order Applied Biosystems user documents, MSDSs, certificates of analysis, and other related documents
- Download PDF documents
- Obtain information about customer training
- Download software updates and patches
- Contact technical services by clicking the Care Center link.

In addition, the Support page provides access to worldwide telephone and fax numbers to contact Applied Biosystems Technical Support and Sales facilities.
TVK Support  To send the temperature verification kit equipment for recalibration:

1. Use the address or Fax information below to request a quote from Alpha Technics for a recalibration order:
   • Mail: Alpha Technics
     17151 Gillette Avenue
     Irvine, Ca. 92614-5602
   • Fax: (949)-271-2300

2. Ensure that the probe assembly has been decontaminated (see “Decontaminating the Probe Assembly” on page 5-13).

3. Pack the digital thermometer and the probe assembly in the black case.

4. Create a shipping package with:
   • Black case containing the digital thermometer and probe assembly
   • Completed copy of the Certificate of Instrument Decontamination
   • Payment for shipping/handling in one of the following forms:
     – Purchase order
     – Company letterhead with the words “verbal purchase order”
     – Visa/MasterCard credit card information
   • Your address and contact information:
     – Billing address
     – Return shipping address
     – Name and phone number of a contact (person most familiar with the thermometer)

Note: If payment is not included with the package, Alpha Technics bills you for $150.00 plus a 10% administrative fee. The total for the purchase order is then $165.00.

5. Send the package freight prepaid to Alpha Technics at the address in step 1.
Safety and EMC Compliance Information

This section covers:

Safety Conventions Used in This Document .................................................. xii
Symbols on Instruments .................................................................................. xiii
Safety Labels on Instruments ......................................................................... xiv
General Instrument Safety ............................................................................. xv
Chemical Safety ............................................................................................... xvi
Chemical Waste Safety .................................................................................... xvii
Electrical Safety ............................................................................................... xvii
Physical Hazard Safety .................................................................................... xvii
Safety and Electromagnetic Compatibility (EMC) Standards ......................... xvii
Safety and EMC Compliance Information

Safety Conventions Used in This Document

Four safety alert words appear in Applied Biosystems user documentation at points in the document where you need to be aware of relevant hazards. Each alert word—IMPORTANT, CAUTION, WARNING, DANGER—implies a particular level of observation or action, as defined below.

Definitions

IMPORTANT! – Indicates information that is necessary for proper instrument operation, accurate chemistry kit use, or safe use of a chemical.

CAUTION – Indicates a potentially hazardous situation that, if not avoided, may result in minor or moderate injury. It may also be used to alert against unsafe practices.

WARNING – Indicates a potentially hazardous situation that, if not avoided, could result in death or serious injury.

DANGER – Indicates an imminently hazardous situation that, if not avoided, will result in death or serious injury. This signal word is to be limited to the most extreme situations.

Except for IMPORTANTs, each safety alert word in an Applied Biosystems document appears with an open triangle figure that contains a hazard symbol. These hazard symbols are identical to the hazard symbols that are affixed to Applied Biosystems instruments (see “Safety Symbols” on page xiii).

Examples

The following examples show the use of safety alert words:

IMPORTANT! You must create a separate sample entry spreadsheet for each 96-well plate.

CAUTION The lamp is extremely hot. Do not touch the lamp until it has cooled to room temperature.

WARNING CHEMICAL HAZARD. Formamide. Exposure causes eye, skin, and respiratory tract irritation. It is a possible developmental and birth defect hazard. Read the MSDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

DANGER ELECTRICAL HAZARD. Failure to ground the instrument properly can lead to an electrical shock. Ground the instrument according to the provided instructions.
Symbols on Instruments

The following table describes the electrical symbols that may be displayed on Applied Biosystems instruments.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="On" /></td>
<td>Indicates the <strong>On</strong> position of the main power switch.</td>
</tr>
<tr>
<td><img src="image" alt="Off" /></td>
<td>Indicates the <strong>Off</strong> position of the main power switch.</td>
</tr>
<tr>
<td><img src="image" alt="Standby" /></td>
<td>Indicates a standby switch by which the instrument is switched on to the <strong>Standby</strong> condition. Hazardous voltage may be present if this switch is on standby.</td>
</tr>
<tr>
<td><img src="image" alt="On/Off" /></td>
<td>Indicates the <strong>On/Off</strong> position of a push-push main power switch.</td>
</tr>
<tr>
<td><img src="image" alt="Ground" /></td>
<td>Indicates a terminal that may be connected to the signal ground reference of another instrument. This is not a protected ground terminal.</td>
</tr>
<tr>
<td><img src="image" alt="Ground" /></td>
<td>Indicates a protective grounding terminal that must be connected to earth ground before any other electrical connections are made to the instrument.</td>
</tr>
<tr>
<td><img src="image" alt="Alternating Current" /></td>
<td>Indicates a terminal that can receive or supply alternating or direct current or voltage.</td>
</tr>
</tbody>
</table>

Safety Symbols

The following table describes the safety symbols that may be displayed on Applied Biosystems instruments. Each symbol may appear by itself or with text that explains the relevant hazard (see “Safety Labels on Instruments” on page xiv). These safety symbols may also appear next to DANGERS, WARNINGS, and CAUTIONS that occur in the text of this and other product-support documents.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Warning" /></td>
<td>Indicates that you should consult the manual for further information and to proceed with appropriate caution.</td>
</tr>
<tr>
<td><img src="image" alt="Shock" /></td>
<td>Indicates the presence of an electrical shock hazard and to proceed with appropriate caution.</td>
</tr>
</tbody>
</table>
Safety and EMC Compliance Information

Environmental Symbols on Instruments

The following symbol applies to all Applied Biosystems electrical and electronic products placed on the European market after August 13, 2005.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>Indicates the presence of a hot surface or other high-temperature hazard and to proceed with appropriate caution.</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>Indicates the presence of a laser inside the instrument and to proceed with appropriate caution.</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>Indicates the presence of moving parts and to proceed with appropriate caution.</td>
</tr>
</tbody>
</table>

Safety Labels on Instruments

The following CAUTION, WARNING, and DANGER statements may be displayed on Applied Biosystems instruments in combination with the safety symbols described in the preceding section.

<table>
<thead>
<tr>
<th>English</th>
<th>Francais</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CAUTION</strong> Hazardous chemicals. Read the Material Safety Data Sheets (MSDSs) before handling.</td>
<td><strong>ATTENTION</strong> Produits chimiques dangereux. Lire les fiches techniques de sûreté de matériels avant la manipulation des produits.</td>
</tr>
<tr>
<td><strong>CAUTION</strong> Hazardous waste. Refer to MSDS(s) and local regulations for handling and disposal.</td>
<td><strong>ATTENTION</strong> Déchets dangereux. Lire les fiches techniques de sûreté de matériels et la régulation locale associées à la manipulation et l’élimination des déchets.</td>
</tr>
<tr>
<td><strong>WARNING</strong> Hot lamp.</td>
<td><strong>AVERTISSEMENT</strong> Lampe brûlante.</td>
</tr>
</tbody>
</table>
General Instrument Safety

**WARNING** PHYSICAL INJURY HAZARD. Using the instrument in a manner not specified by Applied Biosystems may result in personal injury or damage to the instrument.

**Moving and Lifting the Instrument**

**CAUTION** PHYSICAL INJURY HAZARD. The instrument is to be moved and positioned only by the personnel or vendor specified in the applicable site preparation guide. If you decide to lift or move the instrument after it has been installed, do not attempt to lift or move the instrument without the assistance of others, the use of appropriate moving equipment, and proper lifting techniques. Improper lifting can cause painful and permanent back injury. Depending on the weight, moving or lifting an instrument may require two or more persons.

**Operating the Instrument**

Ensure that anyone who operates the instrument has:

- Received instructions in both general safety practices for laboratories and specific safety practices for the instrument.
- Read and understood all applicable Material Safety Data Sheets (MSDSs). See “About MSDSs” on page xvi.

**Cleaning or Decontaminating the Instrument**

**CAUTION** Before using a cleaning or decontamination method other than those recommended by the manufacturer, verify with the manufacturer that the proposed method will not damage the equipment.
Safety and EMC Compliance Information

Chemical Safety

Chemical Hazard Warning

⚠️ WARNING CHEMICAL HAZARD. Before handling any chemicals, refer to the Material Safety Data Sheet (MSDS) provided by the manufacturer, and observe all relevant precautions.

About MSDSs

Chemical manufacturers supply current Material Safety Data Sheets (MSDSs) with shipments of hazardous chemicals to new customers. They also provide MSDSs with the first shipment of a hazardous chemical to a customer after an MSDS has been updated. MSDSs provide the safety information you need to store, handle, transport, and dispose of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous chemical, be sure to replace the appropriate MSDS in your files.

Obtain MSDSs from Applied Biosystems

The MSDS for any chemical supplied by Applied Biosystems is available to you free 24 hours a day. To obtain MSDSs:

1. Go to www.appliedbiosystems.com, click Support, then click MSDS Search.
2. In the Keyword Search field, enter the chemical name, product name, MSDS part number, or other information that appears in the MSDS of interest, then click Search.
3. Find the MSDS of interest, click the link or right-click the MSDS title, then select any of the following:
   - Open – To view the MSDS
   - Print Target – To print the MSDS
   - Save Target As – To download a PDF version of the MSDS

Note: For the MSDSs of chemicals not distributed by Applied Biosystems, contact the chemical manufacturer.

Chemical Safety Guidelines

To minimize the hazards of chemicals:

- Read and understand the Material Safety Data Sheets (MSDSs) provided by the chemical manufacturer before you store, handle, or work with any chemicals or hazardous materials. (See “About MSDSs” on page xvi.)
- Minimize contact with chemicals. Wear appropriate personal protective equipment when handling chemicals (for example, safety glasses, gloves, or protective clothing). For additional safety guidelines, consult the MSDS.
- Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with adequate ventilation (for example, fume hood). For additional safety guidelines, consult the MSDS.
- Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer’s cleanup procedures as recommended in the MSDS.
- Comply with all local, state/provincial, or national laws and regulations related to chemical storage, handling, and disposal.
Chemical Waste Safety

Chemical Waste Hazard

⚠️ **CAUTION** HAZARDOUS WASTE. Refer to Material Safety Data Sheets and local regulations for handling and disposal.

Electrical Safety

⚠️ **DANGER** ELECTRICAL SHOCK HAZARD. Severe electrical shock can result from operating the Veriti Thermal Cycler without its instrument panels in place. Do not remove instrument panels. High-voltage contacts are exposed when instrument panels are removed from the instrument.

**Fuses**

⚠️ **CAUTION** FIRE HAZARD. Improper fuses or high-voltage supply can damage the instrument wiring system and cause a fire. Before turning on the instrument, verify that the fuses are properly installed and that the instrument voltage matches the power supply in your laboratory.

⚠️ **CAUTION** FIRE HAZARD. For continued protection against the risk of fire, replace fuses only with fuses of the type and rating specified for the instrument.

**Power**

⚠️ **DANGER** ELECTRICAL HAZARD. Grounding circuit continuity is vital for the safe operation of equipment. Never operate equipment with the grounding conductor disconnected. Use properly configured and approved line cords for the voltage supply in your facility. Plug the system into a properly grounded receptacle with adequate current capacity.

**Overvoltage Rating**

The Veriti Thermal Cycler has an installation (overvoltage) category of II, and is classified as portable equipment

Physical Hazard Safety

**Moving Parts**

⚠️ **WARNING** PHYSICAL INJURY HAZARD. Moving parts can crush and cut. Keep hands clear of moving parts while operating the instrument. Disconnect power before servicing the instrument.

Safety and Electromagnetic Compatibility (EMC) Standards

This section provides information on:

- U.S. and Canadian Safety Standards
- Canadian EMC Standard
- European Safety and EMC Standards
- Australian EMC Standards
Safety and EMC Compliance Information

**U.S. and Canadian Safety Standards**

The Veriti Thermal Cycler has been tested to and complies with standard:


UL 61010A-2-010, “Particular Requirements for Laboratory Equipment for the Heating of Materials.”

**Canadian EMC Standard**

This instrument has been tested to and complies with ICES-001, Issue 3: “Industrial, Scientific, and Medical Radio Frequency Generators.”

**European Safety and EMC Standards**

**Safety**

This instrument meets European requirements for safety (Low Voltage Directive 2006/95/EC). This instrument has been tested to and complies with standards


EN 61010-2-010, “Particular Requirements for Laboratory Equipment for the Heating of Materials.”

EN 61010-2-081, “Particular Requirements for Automatic and Semi-Automatic Laboratory Equipment for Analysis and Other Purposes.”

**EMC**

This instrument meets European requirements for emission and immunity (EMC Directive 2004/108/EC). This instrument has been tested to and complies with standard EN 61326 (Group 1, Class B), “Electrical Equipment for Measurement, Control and Laboratory Use – EMC Requirements.”

**Australian EMC Standards**

This instrument has been tested to and complies with standard AS/NZS 2064, “Limits and Methods Measurement of Electromagnetic Disturbance Characteristics of Industrial, Scientific, and Medical (ISM) Radio-frequency Equipment.”
System Overview

This chapter covers:

- Introducing the Veriti™ Thermal Cycler ........................................... 1-2
- Using the Touchscreen ................................................................. 1-3
- Menu Overview ............................................................................. 1-6
- About Run Methods ..................................................................... 1-8
- About Folders ............................................................................. 1-15
Introducing the Veriti™ Thermal Cycler

There are four models of the Veriti™ Thermal Cycler:

- Veriti 96-Well Fast Thermal Cycler (PN 4375305), with 0.1–mL sample wells
- Veriti 96-Well Thermal Cycler (PN 4375786), with 0.2–mL sample wells
- Veriti 384-Well Thermal Cycler (PN 4388444), with 0.02–mL sample wells
- Veriti 60-Well Thermal Cycler (PN 4384638), with 0.5–mL sample wells

You control the Veriti Thermal Cycler using the touchscreen display and easy-to-use interface. Up to twelve Veriti Thermal Cyclers can be connected in a satellite-like format through a network switch. With this connection, you can transmit run methods from one Veriti thermal cycler to another and start multiple thermal cyclers at once.

The Veriti Thermal Cycler has a run recovery feature. If a power failure occurs during a run, the instrument will attempt to continue the run when the power returns.

In addition, the Veriti 96-Well Thermal Cyclers have VeriFlex™ Blocks. These are six independently regulated thermal blocks to aid in designing a primer set and run method for optimal PCR conditions.

Figure 1-1  The Applied Biosystems Veriti™ Thermal Cycler

This user guide provides information on how to maximize the capabilities of your new Veriti Thermal Cycler. This user guide provides instructions for all four models of the Veriti Thermal Cycler. Functions which are not the same for each model are indicated by a comment such as “This function is only available for the Veriti 96-Well Thermal Cyclers”.
Detailed specifications for the Veriti Thermal Cycler are found in Appendix A, “Instrument Specifications.”

**Using the Touchscreen**

You interact with the Veriti Thermal Cycler using a touchscreen. Table 1 describes several buttons common to many of the touchscreens.

**Table 1 Buttons in the Veriti™ Thermal Cycler touchscreen**

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Home icon]</td>
<td>Returns to the Main Menu screen.</td>
</tr>
<tr>
<td>![Backward and Forward icons]</td>
<td>Returns to the previous screen.</td>
</tr>
<tr>
<td>![Status Report icon]</td>
<td>When a run is in progress, displays the Status Report to view any errors that occurred during the run.</td>
</tr>
<tr>
<td>![Up and Down icons]</td>
<td>Scrolls up and down through a list of items.</td>
</tr>
<tr>
<td>![Run Monitor icon]</td>
<td>When a run is in progress, displays the Run Monitor screen to view the run.</td>
</tr>
<tr>
<td>![Folders icon]</td>
<td>Displays the run method folders.</td>
</tr>
<tr>
<td>![Shortcut icon]</td>
<td>Creates a “shortcut” to the selected run method (or methods).</td>
</tr>
<tr>
<td>![USB icon]</td>
<td>Indicates that a USB drive is connected to the instrument’s USB port.</td>
</tr>
<tr>
<td>![Help icon]</td>
<td>Opens the Help system.</td>
</tr>
</tbody>
</table>
Entering Text  When you touch a field that requires the input of text, the text editor opens (Figure 1-2).

![Figure 1-2 The Veriti™ Thermal Cycler text editor](image)

<table>
<thead>
<tr>
<th>To...</th>
<th>Touch...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter a lowercase letter</td>
<td>A letter button.</td>
</tr>
<tr>
<td>Enter an uppercase letter</td>
<td>Caps, then the letter(s). When you are done, touch Caps again.</td>
</tr>
<tr>
<td>Enter punctuation or other symbols</td>
<td>Symbols, then the symbol(s). When you are done, touch Symbols again.</td>
</tr>
<tr>
<td>Remove the contents of the entire field</td>
<td>Clear</td>
</tr>
<tr>
<td>Delete the last letter</td>
<td>←</td>
</tr>
<tr>
<td>Close the editor and save any changes</td>
<td>Done</td>
</tr>
</tbody>
</table>
Entering Numerals

When you touch a field that requires only numerical input, the numeric editor opens (Figure 1-3).

![The Veriti™ Thermal Cycler numeric editor](image)

Figure 1-3 The Veriti™ Thermal Cycler numeric editor

<table>
<thead>
<tr>
<th>To...</th>
<th>Touch...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter a number</td>
<td>A number button.</td>
</tr>
<tr>
<td></td>
<td>The instrument automatically adds the decimal point for those fields that include a decimal point, such as a temperature value.</td>
</tr>
<tr>
<td></td>
<td>Colons (for entering times) and dashes (for entering dates) are also automatically added.</td>
</tr>
<tr>
<td>Delete the last number</td>
<td><img src="image" alt="←" /></td>
</tr>
<tr>
<td>Remove the entire contents of the field</td>
<td><img src="image" alt="Clear" /></td>
</tr>
<tr>
<td>Close the editor and save any changes</td>
<td><img src="image" alt="Done" /></td>
</tr>
</tbody>
</table>
Menu Overview

The Main Menu Screen

After you log in to the system, the Main Menu screen opens. This screen is the starting point for operating the Veriti Thermal Cycler. The date, current time, and current user are shown at the bottom of the screen.

If your system does not require login, the My Account button is not shown.

In the Main Menu screen, touch:

- **Browse/New Methods** to view and work with all the run methods to which you have access (see “Viewing a Run Method” on page 1-9).
- **Settings Menu** to access various instrument configuration options. If you have administrative privileges, you access the Admin Menu screen from this screen (see “The Settings Menu Screen” on page 1-7).
- **Tools Menu** to access instrument tests, tools such as a Tm calculator and run method conversion, as well as viewing the results of the last run and statistics about the instrument (see “The Tools Menu Screen” on page 1-8).
- **My Account** to view and edit your account information. If your system does not require login, this button is not shown.
- The **Shortcut** buttons allow you to configure instrument functions you frequently use to appear in the Main Menu screen (see “Configuring Main Menu Shortcuts to Functions” on page 2-15).
- **Log Off** to log off the instrument. You can still log off when a run is in process. If your system does not require login, the (Power) button is shown instead.
- (Help) to access the Help system.
The Settings Menu Screen

Use this screen to set various instrument configuration options.
For instruments that require login, only Users and Administrators have access to this menu.

![Settings Menu Screen](image)

Figure 1-5  The Settings Menu screen, with the Admin Menu button shown

The Admin Menu Screen

Use this screen to manage user accounts, set instrument security, back up run methods and settings, upgrade the firmware, and perform other functions.
If your system does not require login, the Manage Users button is not shown.
For instruments that require login, only Administrators have access to this menu.

![Admin Menu Screen](image)

Figure 1-6  The Admin Menu screen, available only to users with administrative privileges
The Tools Menu Screen

Use this screen to access various tools and instrument tests.

![Tools Menu Screen](image)

Figure 1-7 The Tools Menu screen, available to all users

For more information about the functions on the Tools Menu, see Chapter 5, “Utilities.”

About Run Methods

What Is a Run Method?

A run method is a set of instructions that specifies how the instrument should heat and cool your samples. Run methods are stored in the instrument firmware.

Predefined Methods

The Veriti Thermal Cycler firmware has ten predefined run methods:

- AmpliCycle® Seq Run Method
- AmpliTaq Gold® DNA Polymerase Run Method
- AmpliTaq Gold® Fast PCR Run Method
- BigDye® Kit Standard Run Method
- BigDye® Kit Fast Run Method
- Fast PCR Run Method
- General PCR Run Method
- LMS2 Run Method
- Time Release Run Method
- Touchdown PCR Run Method
- XL PCR Run Method

Each method is stored in the Shared folder. You can edit, copy, and run these predefined methods as you would any other run method, but you cannot delete them.

For details on these methods, see Appendix C, “Predefined Run Methods.”
Viewing a Run Method

To view a run method:

1. In the Browse Run Methods screen, touch a run method to select it, then touch **View/Edit**.

The run method is displayed:

![Edit Run Method: LMS2](image)

**IMPORTANT!** If you are logged on as a Limited User, you can make changes to the run method but you cannot save it. If you are logged on as a Guest, you can make changes to the run method but you can only save it to a USB drive.

2. To view:
   - Other steps in the run method – Touch the arrow buttons at the end of the run method.
   - View steps with ramp rates – Touch **Options**, then **Ramp Rate**. The fields showing times update to show the corresponding ramp rates.

3. When you are done, touch **X** to return to the Browse Run Methods screen.
Managing Run Methods

To see the run methods in the current folder:

- In the Main Menu screen, touch **Browse/New Methods**.

The Browse Run Methods screen is displayed. The title includes the number of run methods in parentheses.

To select a run method:

1. If a run method is already selected in the Browse Run Methods screen:
   a. Touch the row for the selected method to deselect it.
   b. Touch the row for the method of interest.

2. To select more than one method, touch each method.

Table 2 lists the administrative tasks you can perform for run methods.

Table 2 Managing run methods

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort run methods by different criteria</td>
<td>Touch the title of the column with the criteria by which you want to sort the run methods. Touch the title a second time to sort in the opposite order.</td>
</tr>
<tr>
<td>View more run methods in the current folder</td>
<td>Touch (Page Down).</td>
</tr>
<tr>
<td>View run methods in a different folder</td>
<td>Touch (folders). In the Manage Folders All screen that opens, touch the folder you want to view.</td>
</tr>
<tr>
<td>Start a run</td>
<td>In the list of run methods, touch a run method to select it, then touch Start Run (see “Performing a Run” on page 3-18).</td>
</tr>
</tbody>
</table>
Table 2 Managing run methods  (continued)

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new run method</td>
<td>Touch <strong>New</strong> (see “Creating a New Run Method” on page 3-8).</td>
</tr>
<tr>
<td>View or edit a run method</td>
<td>In the list of run methods, touch the run method to select it, then touch <strong>View/Edit</strong> (see “Editing Details” on page 3-10).</td>
</tr>
<tr>
<td>Copy one or more run methods</td>
<td>In the list of run methods, touch each run method to select it, then touch <strong>Copy</strong> (see “Copying a Run Method” on page 1-11).</td>
</tr>
<tr>
<td>Print a run method</td>
<td>In the list of run methods, touch a run method to select it, then touch <strong>Print</strong> (see “Printing a Run Method” on page 1-12).</td>
</tr>
<tr>
<td>Delete one or more run methods</td>
<td>In the list of methods, touch each run method to select it, then touch <strong>Delete</strong> (see “Deleting a Run Method” on page 1-12).</td>
</tr>
<tr>
<td>Designate a run method as the default</td>
<td>See “Designating a Run Method as the Default” on page 1-12.</td>
</tr>
<tr>
<td>Create a shortcut to a run method on the Main Menu</td>
<td>In the list of run methods, touch each run method to select it, then touch <strong>Create Method Shortcut.</strong> (see “Creating a Shortcut to a Run Method” on page 1-13).</td>
</tr>
<tr>
<td>Back up run methods</td>
<td>See “Backing Up Run Methods and Other Settings” on page 1-13.</td>
</tr>
<tr>
<td>Restore run methods that you previously backed up</td>
<td>See “Restoring Run Methods and Other Settings” on page 1-14.</td>
</tr>
</tbody>
</table>

**Copying a Run Method**

*Note:* If your instrument requires login, you must have User or Administrator level permissions to copy a run method.

**To copy a run method:**

1. Log in as a user with User or Administrator access.
2. In the Browse Run Methods screen, find the run method or methods you want to copy.
3. Touch each run method to select it, then touch **Copy**.
4. In the Save Run Method screen:
   a. If you are copying one method – touch **Name**, then rename the method, and/or touch **Folder** to save the run method to a different folder.
   
   *or*

   If you are copying more than one method – touch **Folder** to save the run methods to a different folder.
b. As needed, touch **Reaction Volume, Cover Temperature** and **Notes** to edit the values. You can change any of these values when you perform a run with this run method.

c. Touch **Save & Exit**, then **OK**.

**Printing a Run Method**

*Note:* Before you print a run method, be sure your instrument is connected to a printer. See “Connecting to a Network Printer” on page 2-5.

1. In the Browse Run Methods screen, locate the run method you want to print.
2. Touch the run method to select it, then touch **Print**.

**Deleting a Run Method**

*Note:* If your instrument requires log in, you must have User or Administrator level permissions to delete a run method.

To delete a run method:

1. Log in as a user with User or Administrator access.
2. In the Browse Run Methods screen, find the run method you want to delete.
3. Touch the run method to select it, then touch **Delete**.
4. In the dialog box that opens, verify the deletion.
5. Touch **Yes** in the message box.

The run method is deleted.

**Designating a Run Method as the Default**

The run method that is designated as the default method is used as the starting point for all new methods. The Veriti Thermal Cycler uses the General PCR run method (shown on page C-5) as the default, unless you change to another method.

**IMPORTANT!** If your instrument requires login, you must have User or Administrator level permissions to set the default run method. Only a run method in the Shared folder can be set as the default method.

To designate a run method as the default:

1. Log in as a user with User or Administrator access.
2. In the Main Menu screen, touch **Settings Menu**.
3. In the Settings Menu screen, touch **Set Default Method**.

   The Set the Default Run Method screen is displayed, with only the run methods in the Shared folder displayed.

4. In the Set the Default Run Method, touch the run method you wish to designate as the default, then touch **Make Default**. In the message box that opens, touch **OK**.

   The Settings Menu screen opens and the selected run method is now the default.
Creating a Shortcut to a Run Method

You can add buttons to the Main Menu screen that allow you to go directly to the Edit Run Method screen for a particular run method. When login is required, each user can configure his or her own shortcut buttons; otherwise the shortcut buttons are displayed for all instrument users.

**Note:** You can also create shortcuts to instrument functions (see “Configuring Main Menu Shortcuts to Functions” on page 2-15).

1. In the Browse Run Methods screen, touch one or more methods, then touch *(Create Method Shortcut)*.

2. In the message box that appears, touch **OK**.

   The selected run methods appear as buttons in the Main Menu screen. The name of the method is followed by the name, in parentheses, of the folder where the method is stored.

   **Note:** Run method names longer than twelve characters will appear truncated on the shortcut button.

To delete a shortcut to a run method, see “Configuring Main Menu Shortcuts to Functions” on page 2-15.

Backing Up Run Methods and Other Settings

You can back up the instrument's run methods and other settings to a USB drive. All run methods, folders, user information, and other instrument settings are saved.

**Note:** If your instrument requires login, you must have Administrator level permissions to back up run methods and instrument settings.

1. Insert the USB drive into the USB port on the front of the instrument.

2. Log in as a user with Administrator access.

3. In the Main Menu screen, touch **Settings Menu**, then **Admin Menu**.
4. In the Admin Menu screen, touch **Back Up Methods & Settings**.
   The Back Up Method and Settings screen is displayed:

   ![Back Up Methods and Settings](image)

5. Touch **Back Up**.
   If a back up file already exists, you are prompted to overwrite it.
   The instrument copies all run methods, folders, user information, and other instrument settings to the USB drive, then displays a message box when the backup is complete.

6. Touch **OK**, then touch **(Close)** to return to the Admin Menu screen.

7. Remove the USB drive and store it in a safe place.

**Restoring Run Methods and Other Settings**
You can restore run methods and other settings from a USB drive to an instrument. The restore feature can also be used to load run methods onto another instrument in your lab.

**To restore run methods and instrument settings:**

1. Insert the USB drive containing the saved run methods and settings into the USB port on the front of the instrument.

2. Open the About the Instrument screen in one of the following ways:
   - Touch **Log Off** to return to the Login Options screen, then touch **About the Instrument**.
   - In the Main Menu screen, touch **Settings Menu**, then **About the Instrument**.
Chapter 1 System Overview

The About the Instrument screen is displayed:

3. In the About the Instrument screen, touch Restore Methods & Settings, then Yes in the message box.

The instrument copies all run methods, folders, user information, and other instrument settings from the USB drive to the instrument, then displays a message box when the restore is complete.

4. Remove the USB drive and store it in a safe place.

5. Toggle the switch on the back of the instrument to power off.

6. Toggle the switch again to power on the instrument.

IMPORTANT! If you restore information to an instrument that is different from the instrument that provided the backup data and your instruments are on a network, you should change the instrument’s name. See “Setting the Instrument Name” on page 2-8.

About Folders

Each run method is saved in a folder. There are three folders available by default:

- Default – Run methods are stored here if you do not select another folder. Run methods stored in this folder, run methods can be accessed, edited, run, and deleted only by the user who created them. The Default folder has a blue button.
- Shared – Run methods can be accessed, edited, run, and deleted by any user. In the Browse Folders screen, the Shared folder has a blue button.
- USB – This folder shows all run methods on the USB drive. If a USB drive is present in the instrument, this button is blue, otherwise it is grey.

In addition, you may create up to nine custom folders. In a custom folder, run methods can be accessed, edited, run, and deleted only by the user who created them. In the Manage Folders screen, custom folders have a yellow button.
You can create a new folder when you save a run method (see step 6 on page 3-9) or you can create one by touching New in the Manage Folders screen.

**Deleting Custom Folders**

You can delete any custom folder. When you delete a custom folder, all run methods in that folder are also deleted.

1. In the Main Menu screen, touch Settings Menu.
2. In the Settings Menu screen, touch Manage Folders.
3. In the Manage Folders screen, touch the button for the folder you want to delete, then touch Delete.
4. Touch Yes in the dialog box that opens, then OK.
   The folder is deleted.
5. Repeat steps 3 and 4 to delete other folders.
6. When you are done making changes to folders, touch (Close) to return to the Settings Menu screen.

**Renaming Custom Folders**

You can rename any custom folder.

1. In the Main Menu screen, touch Settings Menu.
2. In the Settings Menu screen, touch Manage Folders.
3. In the Manage Folders screen, touch the button for the folder you want to rename, then touch Rename.
4. Enter up to 12 characters for the folder’s new name, then touch Done to return to the Manage Folders screen.
5. Repeat steps 3 and 4 to rename any other folders.
6. When you are done making changes to folders, touch (Close) to return to the Settings Menu screen.
Getting Started

This chapter covers:

Installing the Veriti™ Thermal Cycler .......................... 2-2
Setting Up the Veriti™ Thermal Cycler ......................... 2-7
Installing the Veriti™ Thermal Cycler

Before You Start

Site Requirements

The Veriti™ Thermal Cycler is for indoor use. Ensure that the installation site:

- Meets the spatial and weight requirements (see “System Specifications,” below)
- Meets environmental requirements (see “Environmental Requirements,” below)
- Is within 1 m (3 ft.) of a 800 VA power receptacle
- Is away from water

System Specifications

Table 1 Physical dimensions, weight, and power consumption

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Instrument Footprint</th>
<th>Recommended Clearance</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>48.5 cm (19.1 in)</td>
<td>15.5 cm (6.1 in)‡</td>
<td>64 cm (15.2 in)</td>
</tr>
<tr>
<td>Width</td>
<td>23.7 cm (9.3 in)</td>
<td>0 cm (0 in)</td>
<td>23.7 cm (9.3 in)</td>
</tr>
<tr>
<td>Height§</td>
<td>40.0 cm (15.7 in)</td>
<td>15.5 cm (6.1 in)§</td>
<td>55.5 cm (21.8 in)</td>
</tr>
<tr>
<td>Weight</td>
<td></td>
<td>10.6 kg (22.6 lbs)</td>
<td></td>
</tr>
<tr>
<td>Power Consumption</td>
<td>800 VA – Maximum consumption</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>~260 VA – Average during thermal cycling</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>~10 VA – During sleep/standby</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

‡ At the rear of the instrument to ensure adequate airflow and cooling.
§ With the heated cover open
# Above the instrument to provide adequate space for opening the heated cover, as shown below.

1 square. = 10 cm² (3.94 in²)
Environmental Requirements

Temperature and Humidity Requirements

Ensure that the installation site is maintained under the following conditions:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Acceptable Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td>15 to 30 °C (59 to 86 °F)</td>
</tr>
<tr>
<td>Humidity</td>
<td>20 to 80% relative humidity, noncondensing</td>
</tr>
</tbody>
</table>

Avoid placing the instrument adjacent to heaters, cooling ducts, or in direct sunlight. Fluctuations between day and night temperatures can cause system instability. Place away from any equipment that vibrates, such as a refrigerator or centrifuge.

Pollution

The Veriti Thermal Cycler has a Pollution Degree rating of 2. It may be installed in an environment that has nonconductive pollutants only, such as dust particles or wood chips. Typical environments with a Pollution Degree II rating are laboratories and sales and commercial areas.

Altitude

The safety of Veriti Thermal Cycler use was tested for altitudes up to 2000 ft.

Materials

Required Materials

- Scissors, pocket knife, or box cutter
- Compressed air
- Protective hardware, as appropriate (see below)

Optional Protective Hardware

Applied Biosystems supports the use of the following devices to protect the Veriti Thermal Cycler from damage resulting from electrical hazards and the resultant loss of data. Before installing the system, decide what additional hardware (if any) you want to install.

- Power line regulator (1.5-kVA)
- Surge protector/line conditioner (10-kVA)
- Uninterruptible power supply (1.5-kVA)

Unpacking the Veriti™ System

IMPORTANT! Save the packing materials and box in case you need to ship the instrument to Applied Biosystems for service.

1. To unpack the Veriti™ System:
   a. Cut the straps securing the instrument box.
   b. Cut the tape securing the top flaps of the instrument crate, then open the flaps.
   c. Remove the Veriti™ System Accessories from the instrument and set them aside.
   d. Lift and remove the cover from the instrument crate.
Chapter 2  Getting Started

e. Remove the packing material from the Veriti™ System, then inspect the instrument for shipping damage.

**IMPORTANT!** If the Veriti™ System is damaged, note the location and appearance of the damage, then contact Applied Biosystems Technical Support or your service representative (see “How to Obtain Support” on page viii).

2. Move the Veriti™ System to the desired installation site. Follow these guidelines for lifting and moving:
   - Make sure that you have a secure, comfortable grip.
   - Keep your spine in a neutral position.
   - Bend at the knees and lift with your legs.
   - Do not lift and twist your torso at the same time.

3. Open the bag containing the Veriti™ System Accessories, then verify that it contains:
   - *Applied Biosystems Veriti™ Thermal Cycler User Guide CD*
   - Cable, Power 13A/125V North America (PN 4382067)
   - Cable, Power 10A/220V Europe (PN 4382068)
   - Veriti™ System Starter Kit

**Setting Up the Veriti™ System**

1. Remove the packing material:
   a. Open the Veriti™ System heated cover.
   b. Remove the packing material from the sample block(s).
   c. Using a can of compressed air, deliver a blast of air into each well of the sample block(s) to remove any particles that may have collected during transportation.
   d. Close the heated cover.
2. Connect the power cable to the Veriti™ System.

3. (Optional) Install any of the recommended protective devices (see “Optional Protective Hardware” on page 2-3).

4. Connect the power cable to the 800 VA power source receptacle.

Connecting to a Network Printer

Requirements

The Veriti Thermal Cycler requires a printer that:

- Has an Ethernet port
- Supports the LPD/LPR protocol (often called a “TCP/IP printer”)

1. Plug the Ethernet cable into the Ethernet port on the back of the instrument.

2. Plug the other end of the cable into a network port.

You must also configure the instrument firmware with printer information before you can print (see “Configuring the Instrument for a Printer” on page 2-8).

Connecting Together Multiple Instruments

You Will Need

Connecting your Veriti Thermal Cycler to other Veriti Thermal Cyclers allows you to use one instrument to control others. You can connect together up to 12 instruments.

To connect together multiple Veriti Thermal Cyclers, you need:

- An Ethernet cable for each Veriti Thermal Cycler
- A network switch
- A TCP/IP printer, if you want to print

For best results, do not connect the network switch to your laboratory’s network. Communication between Veriti Thermal Cyclers works best on an isolated system, free from interference by other network traffic.

Making the Connections

1. Connect the Ethernet cable to the back of the thermal cycler and connect the other end of the cable to the network switch.

2. Repeat step 1 for each thermal cycler.

3. Connect the printer to the network switch.

4. Power on the network switch.

5. For each thermal cycler, follow the instructions in “Setting the IP Address” on page 2-7 and “Setting the Instrument Name” on page 2-8.
   - When you set the instrument’s IP address, select Assign IP address dynamically (using DHCP).
   - Make sure each instrument name is unique.
6. Follow the instructions in “Configuring the Instrument for a Printer” on page 2-8.

Powering On

1. Verify that the heated cover is closed.

2. Press the power button on the back left side of the instrument:

   ![Powering On image]

   The instrument powers on and the Main Menu screen is displayed:

   ![Main Menu image]
Setting Up the Veriti™ Thermal Cycler

Recommended Instrument Settings

Before performing a run, be sure to set the following instrument settings:

- Instrument IP address (page 2-7)
- Instrument name (page 2-8)
- Current date and time (page 2-8)
- Printer information, if you want to print run methods or the run report (page 2-8)

Optionally, you can also change the settings for:

- User accounts and security (page 2-9)
- Idle state temperatures for the cover and the sample block(s) (page 2-14)
- Durations for pauses and stand-by (page 2-15)
- “Shortcuts” to instrument functions (to be displayed on the Main Menu) (page 2-15)

Setting the IP Address

Note: If your instrument is not on a network, you do not need to set the IP address. The IP address can be assigned dynamically by a computer on the network (using DHCP) or set manually by entering a number in the IP Address screen.

Note: Ask your system administrator if the IP address is assigned statically or dynamically. For static addresses, you need to know the IP address for the instrument, the subnet mask, and the default gateway.

1. In the Main Menu screen, touch Settings Menu.
2. In the Settings Menu screen, touch Admin Menu.
3. In the Admin Menu screen, touch Set IP Address.
4. In the IP Settings screen, set the IP address:
Chapter 2  Getting Started

- Dynamically – Touch **Assign IP address dynamically (using DHCP)**. A check mark appears when DHCP is selected.

  or

- Manually – Touch **Static**, then enter the appropriate IP addresses for the instrument, the subnet mask, and, optionally, the default gateway using the numeric editor. Addresses are in the form of X.X.X.X, where each X is a 3-digit number, from 001 to 255.

5. Touch **Done**, then **OK** to save your changes and return to the Admin Menu screen.

### Setting the Instrument Name

By default the instrument name is set to the instrument serial number. You can change the name to something more descriptive. The instrument name appears in the About the Instrument and Run Report screens and, if you connect together multiple instruments, in the Select Instruments screen.

1. In the Main Menu screen, touch **Settings Menu**.
2. In the Settings Menu screen, touch **Admin Menu**.
3. In the Admin Menu screen, touch **Set Instrument Name**.
4. Touch the field to enter the new name.
   
   Names cannot contain spaces and cannot be more than 24 alphanumeric characters or, for numeric-only names, 10 characters.

5. Touch **Yes** next to Allow Remote Runs to make the instrument available for remote runs (a run on this instrument can be started from another instrument); otherwise touch **No**.

6. Touch **Done**, then **OK** to save your changes and return to the Admin Menu screen.

**Note:** If you edit the Instrument Name field, you can still view the serial number in the About the Instrument screen. You can access the About the Instrument screen from either the Login screen or the Settings Menu screen.

### Configuring the Instrument for a Printer

If you want to print the run report, test results, and/or a run method, you must configure the instrument with information about the printer.

1. In the Main Menu screen, touch **Settings Menu**.
2. In the Settings Menu screen, touch **Configure Printer**.
3. Touch the fields to set the printer’s name and IP address.
4. Touch **Done** to save your changes and return to the Settings Menu screen.

### Setting the Date and Time

The date and time appear in the run report and at the bottom of many of the screens on the instrument.

1. In the Main Menu screen, touch **Settings Menu**.
2. In the Settings Menu screen, touch **Admin Menu**.
3. In the Admin Menu screen, touch **Set Date & Time**.
4. To set the date, touch **Date**, then enter today’s date, using the format YYYY-MM-DD. The instrument automatically enters the “-”.

5. To set the time, touch **Time**, enter the current time using the format HH:MM, then touch **AM** or **PM**. The instrument automatically enters the “:”.

6. Touch **Done**, then **OK** to save your changes and return to the Admin Menu screen.

---

### Setting Up Instrument Security and User Accounts

By default, the Veriti Thermal Cycler has all security settings disabled, allowing anyone to use the instrument and/or change instrument settings.

**To change the security settings for the instrument:**

1. Log in as a user with Administrator access.
2. In the Main Menu screen, touch **Settings Menu**.
3. In the Settings Menu screen, touch **Admin Menu**.
4. In the Admin Menu screen, touch **Security**.

5. To allow VeritiLink™ Remote Management Software to control this instrument, touch **Yes** next to Allow VeritiLink Software Control.

6. To require each user to log in when using the instrument, touch **Yes** next to Require Login.

7. To allow anyone to log in as a guest, touch **Yes** next to Enable Guest Account.
   A guest user can perform runs, view and print run methods, and run tests. Also, for run methods stored on a USB drive, a guest can create, view, edit, delete, save, and print run methods.
   A guest user cannot manage users or set instrument preferences.

8. To allow users to log in without entering a password, touch **Yes** next to Require Password.
9. Touch **Done**, then touch:
   - **Yes**, to restart the instrument and have the changes take effect immediately. Toggle the switch on the back of the instrument to power off then toggle the switch again to power on the instrument. After you restart, follow the instructions in “Adding Yourself, as a User” on page 2-10. 
   
   or 
   
   - **No** to have the changes take effect the next time the instrument is restarted with the power switch on the back of the instrument.

### Adding Users

#### Access Levels
Each user is assigned an access level that determines how he or she can interact with the instrument. There are three access levels:

- **Limited User** – Can perform runs, view and print run methods, and run tests. Cannot edit or create run methods, manage users, or set instrument preferences.
- **User** – Can perform runs, create, view, edit, delete, save and print run methods, and run tests. Cannot manage users or set instrument preferences.
- **Administrator** – Can access all instrument functions, including setting security, managing users and settings instrument preferences.

#### Adding Yourself, as a User
If you set the instrument to require login, you need to use the default administrator user name and password until you create your own user account.

To add yourself as a user:

1. In the opening screen, touch **On**, then **Log In**.

![Login Screen](image)

2. In the Log In screen, touch:
   a. The **User** field, then enter **admin**.
   b. The **Password** field, then enter **password**.
   c. **Log In**.

3. In the Main Menu screen, touch **Settings Menu**.
4. In the Settings Menu screen, touch Admin Menu.

5. Follow the instructions in “Adding Users” to add yourself as a user. Make sure you make yourself an Administrator.

**Adding Users**

**To add a user:**

1. Log in as a user with Administrator access.
2. In the Main Menu screen, touch Settings Menu.
3. In the Settings Menu screen, touch Admin Menu.
4. In the Admin Menu screen, touch Manage Users.

The Manage Users screen is displayed:

The Create New User Account screen is displayed:

5. Touch Add User.

The Create New User Account screen is displayed:

6. Enter information for the new user. The required fields are User Name, Password, Re-enter Password, and Permission Level.
a. User Name must be between 5 and 15 characters, with no spaces.
b. Password must be at least 1 character.
c. Touch **Set Access**, then touch one of the following:
   - **Limited User**
   - **User**
   - **Administrator**
d. Touch **Done** to close the Permission screen.

7. Touch **Done**, then **OK** to add the user account to the instrument.
   The new user appears in the Manage Accounts screen.

8. When you finish, touch × (Close) to return to the Admin Menu screen.

### Changing a User

#### To edit a user:

1. Log in as a user with Administrator access.
2. In the Main Menu screen, touch **Settings Menu**.
3. In the Settings Menu screen, touch **Admin Menu**.
4. In the Admin Menu screen, touch **Manage Users**.
   The Manage Users screen is displayed:

   ![Manage Users Screen](image)

5. In the list, touch the user in the list, then touch **Edit User**.
The Edit User Account screen is displayed:

6. In the Edit User Account screen, make the required changes:
   - Touch **Phone** and/or **Email** to edit the contents.
   - Touch **Set Access** to change the access level for the user.
   - Touch **Set Password** to change the password for the user.

7. Touch **Done**, then **OK** to return to the Manage Users screen.

8. When you finish, touch (Close) to return to the Admin Menu.

**Deleting a User**

To delete a user:

1. Log in as a user with Administrator access.
2. In the Main Menu screen, touch **Settings Menu**.
3. In the Settings Menu screen, touch **Admin Menu**.
4. In the Admin Menu screen, touch **Manage Users**.
   
The Manage Accounts screen is displayed:
5. In the list, touch the user name for the account you want to delete, then touch **Delete User**.
   A confirmation message appears.

6. Touch **OK** to delete the user and any run methods or folders for that user, then **OK**.

7. When you finish, touch ✗ (Close) to return to the Admin Menu.

### Setting Other Options

**Table 2** lists additional options that can be adjusted or activated. These settings apply to all users.

**Table 2 Additional options (and their default values) for the Veriti Thermal Cycler**

<table>
<thead>
<tr>
<th>Option</th>
<th>Default Value</th>
<th>See Page</th>
</tr>
</thead>
</table>
| Idle temperatures for the cover and the sample block(s) | Cover: 105 °C  
Sample block(s): 25 °C | 2-14     |
| Durations for pause and standby time-outs             | Pause: 10 sec.  
Standby: 1 min. 30 sec. | 2-15     |
| Shortcuts to appear on the Main Menu screen           | None | 2-15     |

**Setting Idle Temperatures for the Block(s) and Cover**

1. In the Main Menu screen, touch **Settings Menu**.

2. In the Settings Menu screen, touch **Set Idle Temperatures**.

3. In the Idle State Temperatures screen, to set the temperatures for the sample block(s) and the cover, touch:
a. **Enabled** to turn the option on. If this is disabled, the temperature for the
cover and/or block(s) is not maintained by the instrument and will
eventually come to room temperature.

b. The **Temperature** field, then enter the temperature. The temperature for
the cover must be between 4 and 99 °C.

4. Touch **Done** to save your changes and return to the Settings Menu screen.

### Setting Time-Outs

1. In the Main Menu screen, touch **Settings Menu**.
2. In the Settings Menu screen, touch **Set Time-outs**.

![Set Time-Outs](image)

3. In the Set Time-Outs screen, touch **Time-out**, then enter the duration.
   - Default Standby Time-Out sets the duration that the instrument is idle
     before it goes to standby mode. The minimum time is 1 minute. Set this value to 00:00 to disable standby mode.
   - Default Pause Duration sets the duration the instrument pauses, after you
     touch Pause during a run.

4. Touch **Done**, then **OK** to save your changes and return to the Settings Menu screen.

### Configuring Main Menu Shortcuts to Functions

You can add buttons to the Main Menu screen that allow you to go directly to various
instrument functions. When login is required, each user can configure his or her own
shortcut buttons; otherwise the shortcut buttons are displayed for all instrument
users.

You can also create shortcuts to run methods (see “Creating a Shortcut to a Run
Method” on page 1-13).

1. In the Main Menu screen, touch:
   - Any button labeled **Shortcut X** (where X is a number).
   - or
   - **Settings Menu**, then **Configure Shortcuts**.
2. In the list of functions available as shortcuts in the Configure Shortcuts screen, touch the functions to select them. Touch (Page Up) and (Page Down) to scroll through the list.

3. Touch Done to return to the Settings Menu screen.

The selected shortcut(s) appear in the Main Menu screen.

Deleting Shortcuts

To delete a shortcut, follow the steps above, but uncheck the function to remove it from the Main Menu. Any run methods for which there is a shortcut are shown at the bottom of the list and can also be deleted.
Performing a Run

This chapter covers:

Selecting Disposables ........................................... 3-2
Loading Samples into the Instrument .......................... 3-5
Creating a New Run Method .................................... 3-8
Editing Details ...................................................... 3-10
Performing a Run .................................................. 3-18
Monitoring a Run ................................................... 3-22
Viewing and Printing the Run Report .......................... 3-25
Removing the Samples from the Instrument ................. 3-25
Selecting Disposables

Use this section to determine the tube, sample tray, and plate configurations appropriate for your thermal cycler and application.

- “Disposables for 96-Well Veriti™ Thermal Cyclers” on page 3-2
- “Disposables for the 384-Well Veriti™ Thermal Cycler” on page 3-4
- “Disposables for the 60-Well Veriti™ Thermal Cycler” on page 3-4

See Appendix B, “Disposables,” for part numbers for these items.

Disposables for 96-Well Veriti™ Thermal Cyclers

96-Well Tube Configurations

**IMPORTANT!** The tray or the tray/retainer is required for the operation of the Veriti Thermal Cycler.

You can use three different types of tube configurations to hold your samples, as shown in Figure 3-1.

- MicroAmp® Fast Reaction Tube with Cap (0.1-mL)
  - or
  - MicroAmp® Reaction Tube with Cap (0.2-mL)

- MicroAmp® Reaction Tube (0.2-mL) with MicroAmp™ 8-Cap Strip

- MicroAmp™ Fast 8-Tube Strip (0.1-mL)
  - or
  - MicroAmp™ 8-Tube Strip (0.2-mL) with MicroAmp™ 8-Cap Strip

Figure 3-1  Different tube configurations for use in 96-Well Veriti Thermal Cyclers
96-Well Sample Tray and Plate Configurations

The following table lists the possible sample tray and plate configurations.

**IMPORTANT!** The MicroAmp™ Splash Free 96-Well Base shown below is used only when pipetting samples into tubes or trays. Do not place it in the sample block(s).

<table>
<thead>
<tr>
<th>Run Vessel</th>
<th>Compatible Component</th>
<th>Illustration</th>
</tr>
</thead>
<tbody>
<tr>
<td>MicroAmp™ Fast Optical 96-Well Reaction Plate (0.1-mL)</td>
<td>MicroAmp™ Caps, 8-Cap Strip or MicroAmp™ Clear Adhesive Film (not shown)</td>
<td><img src="image1" alt="Illustration" /></td>
</tr>
<tr>
<td>MicroAmp™ Optical 96-Well Reaction Plate (0.2-mL)</td>
<td></td>
<td><img src="image2" alt="Illustration" /></td>
</tr>
<tr>
<td>MicroAmp® Fast Reaction Tube with Cap (0.1-mL)</td>
<td>96-Well Tray for Veriflex™ Blocks</td>
<td><img src="image3" alt="Illustration" /></td>
</tr>
<tr>
<td>MicroAmp® Reaction Tube with Cap (0.2-mL)</td>
<td></td>
<td><img src="image4" alt="Illustration" /></td>
</tr>
<tr>
<td>MicroAmp™ 8-Tube Strip (0.2-mL) or MicroAmp® Reaction Tube without Cap (0.2-mL)</td>
<td>MicroAmp™ 8-Cap Strip and MicroAmp™ 96-Well Tray/Retainer Set for Veriti™ Systems</td>
<td><img src="image5" alt="Illustration" /></td>
</tr>
</tbody>
</table>
Disposables for the 384-Well Veriti™ Thermal Cycler

There is one plate configuration for the Veriti 384-Well Thermal Cycler, shown in Figure 3-2, below. This uses the MicroAmp™ Optical 384-Well Reaction Plate.

![MicroAmp™ Optical 384-Well Reaction Plate with MicroAmp™ Clear Adhesive Cover](image)

Disposables for the 60-Well Veriti™ Thermal Cycler

You can use three types of tubes to hold your samples, as shown in Figure 3-3.

- GeneAmp® Thin-Walled Reaction Tube with Flat Cap (0.5-mL)
- GeneAmp® Thin-Walled Reaction Tube with Domed Cap (0.5-mL)
- GeneAmp® Thin-Walled Reaction Tube with Domed Cap, Autoclaved (0.5-mL)

![Different tubes for use in the Veriti™ 384-Well Thermal Cycler](image)
Loading Samples into the Instrument

See the appropriate section for your instrument:

- “Loading Samples in Veriti™ 96-Well Thermal Cyclers” on page 3-5
- “Loading Samples in the Veriti™ 384-Well Thermal Cycler” on page 3-6
- “Loading Samples in the Veriti™ 60-Well Thermal Cycler” on page 3-7

Loading Samples in Veriti™ 96-Well Thermal Cyclers

This section describes how to load samples in:

- Tubes with attached caps
- 96-well reaction plates
- 96-well tray/retainer assemblies

Loading Tubes with Attached Caps

There is no need to use mineral oil or glycerine in the sample wells or as a vapor barrier over the PCR reaction mixture in the tubes. The MicroAmp® Reaction Tubes fit tightly in the wells, and the heated cover exerts an even pressure on all tubes, eliminating condensation on the tubes.

1. Set the 96-well tray on a splash-free 96-well base.
2. Place the reaction tubes in the tray.
3. Pipette the samples into the reaction tubes.
4. Cap the tubes.
5. See “Placing the Sample Tray or Plate onto the Sample Block(s)” on page 3-6.

Loading the Reaction Plate

1. Place the reaction plate on a splash-free 96-well base.
2. Pipette the samples into the sample wells.
3. Cap the plates using the MicroAmp™ 8-Cap Strips, or cover the plates with MicroAmp™ Clear Adhesive Film.
4. See “Placing the Sample Tray or Plate onto the Sample Block(s)” on page 3-6.

Loading Tubes Without Caps

To load the 96-well tray/retainer:

1. Place the tray on the splash-free 96-well base.
2. Load tubes onto the tray using either single tubes or the 8-tube strips.
3. Place the retainer over the tubes.
4. Pipette the sample into the tubes.
5. Cap the tubes using a MicroAmp™ 8-Cap Strip.
6. See “Placing the Sample Tray or Plate onto the Sample Block(s)” on page 3-6.
Placing the Sample Tray or Plate onto the Sample Block(s)

The steps for placing the sample tray in the sample block(s) are the same for:

- A sample tray/retainer
- A sample tray without a retainer
- A 96-well plate.

1. Lift the sample tray from the splash-free 96-well base and place it in the sample block(s).

2. Place the MicroAmp™ Tray or Plate onto the sample block(s) so that well A1 is at the upper left corner of the tray, as shown below:

   ![MicroAmp™ Fast Optical 96-Well Reaction Plate](image1)
   ![MicroAmp™ Optical 96-Well Reaction Plate](image2)

   **IMPORTANT!** Do not place the base in the sample block(s).

3. Close the heated cover.

Loading Samples in the Veriti™ 384-Well Thermal Cycler

This section describes how to load samples in 384-well reaction plates.

1. Pipette the samples into the sample wells.

2. Cover the plates with MicroAmp™ Clear Adhesive Film.

3. Place the MicroAmp™ Optical 384-Well Reaction Plate onto the sample block(s) so that well A1 is at the upper left corner of the tray, as shown below:

   ![MicroAmp™ Optical 384-Well Reaction Plate](image3)

4. Close the heated cover.
Loading Samples in the Veriti™ 60-Well Thermal Cycler

There is no need to use mineral oil or glycerine in the sample wells or as a vapor barrier over the PCR reaction mixture in the tubes. The GeneAmp® Thin-Walled Reaction Tubes fit tightly in the wells, and the heated cover exerts an even pressure on all tubes, eliminating condensation on the tubes.

1. Pipette the samples into the reaction tubes.
2. Cap the tubes.
3. Place the GeneAmp® Thin-Walled Reaction Tubes with Flat or Domed Caps (0.5 mL) onto the sample block(s).
4. Place the GeneAmp® Thermal Isolation Frame around the sample block(s).
5. Close the heated cover.
Creating a New Run Method

1. In the Main Menu screen, touch **Browse/New Methods**.

2. In the Browse Run Methods screen, touch **New**.
   
   The default run method is displayed in the Edit Run Method screen. (For instructions on setting the default run method, see “Designating a Run Method as the Default” on page 1-12.)

3. Edit the default run method as needed:
   
   - Insert a stage (see “Adding a Stage” on page 3-10).
   - Insert a step (see “Adding a Step” on page 3-11).
   - Add an AutoDelta step (see “Creating an AutoDelta Step” on page 3-13).
   - Add a pause (see “Adding a Pause” on page 3-15).
   - Delete a step or stage (see “Deleting a Stage or Step” on page 3-15).
   - For Veriti 96-Well Thermal Cyclers, you can add a step to program different temperatures on the VeriFlex™ Blocks (see “Creating a VeriFlex™ Step” on page 3-16).
4. Touch **Save & Exit** to display the Save Run Method screen.

5. Touch **Run Method** to enter the name of the run method. Names can be up to 48 characters. Names may not contain any of the following characters: %*?|:;!@#$.(<>"/\`~{}[]=+-&^ (tab). Spaces, underscores, and dashes are allowed.

6. Touch **Folder** (Folder) to select a folder in which to save the run method.
   - To save the run method so that all users have access to it, touch **Shared**.
   - To create a new folder for the run method, touch **New Folder** at the bottom of the list, enter a name of up to 12 characters (no spaces), for the new folder, then touch **Done**.
   - To save the run method to the USB drive, touch **USB** (available only when a USB drive is inserted in the instrument).

7. Touch **Reaction Volume** to enter the reaction volume. (You can change this volume when you perform a run with this run method.)

8. Set the cover temperature, if any:
   - **Cover Temperature** to enter the temperature for the heated cover.
   - **Do Not Heat Cover**.

   You can change this temperature when you perform a run with this run method.

9. Touch **Notes**, then enter any notes for the method.

10. Touch **Save & Exit** when you are done.
    The Browse Run Methods screen is displayed.
Editing Details

This section describes how to edit a run method by:

- Adding a stage (page 3-10)
- Adding a step (page 3-11)
- Editing a temperature or a time (page 3-12)
- Editing a ramp rate (page 3-12)
- Creating an AutoDelta step (page 3-13)
- Adding a pause (page 3-15)
- Creating a step to program different temperatures on the VeriFlex Blocks (page 3-16) (Available only on Veriti 96-Well Thermal Cyclers.)

Adding a Stage

The two types of run method stages are:

- **Cycling** – The steps in a cycling stage are repeated a specified number of times. In general, the steps in a cycling stage are template denaturation, primer annealing, and primer extension.

- **Holding** – The steps in a holding stage are not repeated.

To add a stage:

1. In the Edit Run Method screen, touch the stage name (at the top of the stage) to select it. When a stage is selected, the area around the name is red.

2. Touch Add.

A copy of the selected stage is added to the run method.
3. For a cycling stage, edit the number of cycles as needed.
   a. Touch the stage to select it.
   b. Touch the cycles field (the box below the Stage Name) to select it:

   ![Image of Edit Run Method screen]

   c. Enter the number of cycles, then touch **Done**.

4. To change the temperature and/or time for any step in the stage, see “Editing Temperature and Time” on page 3-12.

**Adding a Step**

1. In the Edit Run Method screen, touch anywhere in the column for a step to select it.

   When the step is selected, the column turns red:

   ![Image of Edit Run Method screen with a selected step]

   2. Touch **Add**.

   A copy of the selected step is added to the run method:
3. To change the temperature and/or time for the step, see “Editing Temperature and Time” on page 3-12.

**Editing Temperature and Time**

1. Touch any temperature field to select it, then edit the temperature as desired.

   or

2. Touch any time field to select it, then edit the time as desired.

3. You can edit any other times, temperatures, (or the number of cycles for a stage) without closing the editor.
   a. Touch the field.
   b. Touch the keys in the editor.
   c. Repeat for any other field.

4. Touch **Done** to close the editor.

**Editing Ramp Rates**

You can edit the rate at which the instrument ramps to the temperature for the step. The default ramp rate is 100%.

Note: You cannot edit ramp rates for methods created using the Convert Method wizard (see “Using GeneAmp® PCR System 9700 Run Methods” on page 5-2).

1. Touch a step to select it.

2. Touch **Options**, then **Ramp Rate**.

The field displaying time changes to display the ramp rate.

3. Touch the ramp field, then enter the desired ramp rate.

   Ramp rates from 0.1 to 100% are valid.

4. Touch **Done** to close the editor.

   The ramp rate symbol 🈸 appears next to any step with a ramp rate less than 100%. 
Creating an AutoDelta Step

An AutoDelta step allows you to increase or decrease the temperature and/or change the duration of the cycle during a cycling stage.

One use for an AutoDelta step is for touchdown PCR, a method in which the earliest cycles have a high annealing temperature, followed by cycles where the annealing temperature decreases slightly for each cycle. Touchdown PCR increases the specificity of the PCR products. The high initial temperature favors more specific annealing between the primer and the template. Because these fragments are further amplified during subsequent cycles at lower temperatures, they outcompete the nonspecific sequences to which the primers bind at lower temperatures.

**Note:** AutoDelta steps are allowed only in cycling stages.

**To create an AutoDelta step:**

1. Touch a step, then **Options**.

   The options menu appears:
2. In the Options menu, touch **AutoDelta**.

The Create an AutoDelta Step screen is displayed:

![Create an AutoDelta Step](image)

3. Touch **Starting Cycle**, then enter the cycle at which the AutoDelta step begins.

4. Select the parameter(s) to increment:
   - Touch **Delta Temperature**, then enter the number of degrees that the temperature changes for each cycle. To enter a temperature that decreases with every cycle, touch + to change it to −. To enter a temperature that increases, the button should show +.
   
   *and/or*
   
   - Touch **Delta Time**, then enter the minutes and seconds that the step duration should change with each cycle. To enter a time that decreases with each cycle, touch + to change it to −. To enter a time that increases, the button should show +.

   **Note:** Make sure the parameters you enter result in a final temperature greater than 4.0 °C and less than 99.9 °C. Also, the Delta Time must be less than the total time for the stage.

5. Touch **OK** to save the step and return to the screen that displays the run method.

The AutoDelta symbol **A** appears on the step with the AutoDelta step. In this example, Step 2 in Stage 2 is an AutoDelta step:

![AutoDelta Step Example](image)
Adding a Pause  
You can add a pause before any step in any cycling stage.

1. In the Edit Run Method screen, touch a step in a cycling stage to select it, then touch Options.

2. In the Options Menu, touch Pause to display the Add a Pause Before a Step dialog box:

4. Enter:
   - The first cycle in which the run will pause.
   - The frequency of the pause.
   - The duration of the pause, in mm:ss.

5. Touch Done to save the pause and return to editing the method.

The step preceded by the pause is indicated by the (see Step 3 in Stage 3, below):

Deleting a Stage or Step  
1. In the Edit Run Method screen, touch the stage or step to select it.

2. Touch Delete, then OK.

The stage or step is deleted from the run method.
Creating a VeriFlex™ Step

**Note:** This function is only available for the 96-well versions of the Veriti Thermal Cycler.

The Veriti 96-Well Thermal Cyclers have six VeriFlex™ blocks. You can specify temperatures for each VeriFlex™ block, or treat each VeriFlex™ block the same (the default). The VeriFlex™ blocks can be used to provide up to six different temperature zones for the 96 wells. A step that has different temperatures for different VeriFlex™ blocks is called a “VeriFlex™ step.” This feature is useful for quickly optimizing new run methods.

**To create a step with different temperatures for the VeriFlex™ blocks:**

1. Touch a step, then **Options**.
   The options menu appears:

   ![Options Menu](image)

2. In the Options menu, touch **VeriFlex step**.
   The Create a VeriFlex Step screen is displayed:

   ![Create VeriFlex Step](image)
3. Touch a temperature field, then enter the desired temperature. Temperatures for neighboring VeriFlex™ blocks can be the same, but if they are not the same, they must be at least 0.1 °C apart but no more than 5.0 °C apart. The maximum temperature is 99.9 °C.

4. Repeat step 3 for each of the six VeriFlex™ blocks, then touch **Done**.

   **Note:** To set each block to the same temperature, touch the desired temperature field, then touch **Apply Selected to All**.

5. Depending on your instrument configuration, enter either a duration or a ramp rate.
   - Touch **Time**, enter the duration (in minutes and seconds), then touch **Done**.
   - or
   - Touch **Ramp Rate**, enter the ramp rate (as a percentage value), then touch **Done**.

   The VeriFlex Step appears in the Edit Run Method screen, with the text “Zones” in the temperature field.
Performing a Run

Before You Begin

Prepare your samples and load the sample block(s) as described in “Loading Samples into the Instrument” on page 3-5.

IMPORTANT! You can start a run on multiple instruments at the same time if your instruments are on a network.

To start a run from the Main Menu screen:

1. Close the cover.
2. Touch Browse/New Methods.
3. Locate the run method you want to use (see “Viewing a Run Method” on page 1-9), then touch the run method to select it.
4. Touch Start Run. The Run Parameters screen is displayed:

5. Touch Reaction Volume to edit the reaction volume. By default, the reaction volume you entered when you saved the method is displayed. Reaction volumes are specific to the type of instrument:
   - Veriti 96-Well Fast Thermal Cycler: 5 to 40 µL
   - Veriti 96-Well Thermal Cycler: 10 to 100 µL
   - Veriti 384-Well Thermal Cycler: 5 to 30 µL
   - Veriti 60-Well Thermal Cycler: 10 to 100 µL
6. Set the cover temperature:
   - Cover Temperature to enter the temperature for the heated cover.
   - Do Not Heat Cover.
7. Touch Run ID, and/or Notes, then enter the applicable information.
   The default Run ID is YYYYMMDDHHMM, where “YYYYMMDD” is the date and “HHMM” is the current time.
8. If you are making runs on:
   • **Only this instrument** – Touch **Start Run Now**, then **OK**. The cover is heated to the required temperature, then the run begins. When the run is complete, the Run Report is displayed.
   or
   • **Multiple instruments** – Touch **Start Multiple Runs**. The Select Instrument screen is displayed:

   ![Select Instruments Screen]

   9. In the Select Instrument screen:
      a. Touch the check box corresponding to each instrument on which you want to perform the run. Only instruments that are compatible with the run method are available. Incompatible instruments are indicated by **x**. If you want to perform the run on this instrument, be sure to touch the check box in the upper left corner of the screen.
      b. Touch **Start Run Now**, then **OK**. The run method is sent to each selected instrument, and, if no problems are encountered, the run begins. After the run begins, you must interact with any remote instruments directly if you want to make changes to the run method, pause, or stop the run. When the runs are complete, the Run Reports are displayed on each instrument.
10. While the cover heats, the Cover Heating dialog box appears in the Run Monitor screen:

   ![Image of the Cover Heating dialog box]

   If you want to:
   - *Start* the run immediately, before the cover reaches the specified temperature – Touch ↓ (Skip).
   - *Stop* the run – Touch ■ (Stop).
Monitoring a Run

The Run Monitor Screen

You can follow the status of a run using the Run Monitor screen (below):

![Run Monitor Screen](image)

Table 4: Elements of the Run Monitor screen

<table>
<thead>
<tr>
<th>Location in Figure</th>
<th>Element Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Run Monitor Button and Status Bar</td>
</tr>
<tr>
<td></td>
<td>Displays the estimated temperature of the sample, the temperature of the heated cover, the estimated time remaining in the run, and the current stage.</td>
</tr>
<tr>
<td>B</td>
<td>Hot Icon</td>
</tr>
<tr>
<td></td>
<td>Indicates that the heated cover has achieved a temperature sufficient to burn skin.</td>
</tr>
<tr>
<td>C</td>
<td>Stage Indicator</td>
</tr>
<tr>
<td></td>
<td>Indicates the stage that the Veriti™ System is performing and the current cycle in that stage.</td>
</tr>
<tr>
<td>D</td>
<td>Step Temperature</td>
</tr>
<tr>
<td></td>
<td>Indicates the temperature for the step.</td>
</tr>
<tr>
<td>E</td>
<td>Hold Time</td>
</tr>
<tr>
<td></td>
<td>Indicates the time for the step. When this is the current step, this field counts down.</td>
</tr>
<tr>
<td>F</td>
<td>Step Indicator</td>
</tr>
<tr>
<td></td>
<td>Indicates the step that the Veriti™ System is performing.</td>
</tr>
<tr>
<td>G</td>
<td>Status Report</td>
</tr>
<tr>
<td></td>
<td>Displays the run status and any errors that occur during the run. Touch the triangle to view the entire report.</td>
</tr>
<tr>
<td>H</td>
<td>Arrow Button</td>
</tr>
<tr>
<td></td>
<td>Touch this to see the additional steps in the run method.</td>
</tr>
</tbody>
</table>

See “Actions in the Run Monitor Screen During a Run” on page 3-22 for information about what you can do during a run.
During a run, the touchscreen is active, allowing you to perform the actions indicated in the table.

### Actions in the Run Monitor Screen During a Run

<table>
<thead>
<tr>
<th>To...</th>
<th>Do This</th>
</tr>
</thead>
<tbody>
<tr>
<td>View other stages</td>
<td>Touch the scroll right and scroll left buttons.</td>
</tr>
<tr>
<td>Pause the run</td>
<td>Touch <strong>Pause Run</strong> (see “Pausing a Run” on page 3-23).</td>
</tr>
<tr>
<td>View run method information</td>
<td>Touch <strong>View Method Information</strong>. The information you entered in the Run Parameters dialog box is shown.</td>
</tr>
<tr>
<td>Display the time for the run</td>
<td>Touch <strong>Display Method Time</strong>. The elapsed time and time remaining for the run are shown.</td>
</tr>
<tr>
<td>Skip to the next step</td>
<td>Touch <strong>SKIP</strong>. Skip works only when the instrument is holding.</td>
</tr>
<tr>
<td>Stop the run</td>
<td>Touch <strong>STOP</strong> (see “Stopping a Run” on page 3-23).</td>
</tr>
<tr>
<td>Change the number of cycles for a cycling stage</td>
<td>Touch the Cycle field then change the number of cycles (see “Changing the Number of Cycles” on page 3-22).</td>
</tr>
<tr>
<td>Go to the Main Menu screen</td>
<td>Touch (Home). From the Main Menu Screen, you can access most of the Veriti Thermal Cycler functions while the run continues.</td>
</tr>
<tr>
<td>View the Status Report</td>
<td>Touch (Status).</td>
</tr>
</tbody>
</table>

### Changing the Number of Cycles

You can change the number of cycles for a cycling stage while a run is in progress.

1. If needed, click the orange run monitor button to return to the run monitor screen.

2. Touch the cycles field (below the Stage Name) for a cycling stage, then enter the new value. You cannot:
   - Edit a stage that is already complete.
   - Enter a number that is smaller than the number of cycles that have already been completed.

3. Touch **Send** to return to the Run Monitor screen.
   The run continues, using the new number of cycles.
**Pausing a Run**

1. In the Run Monitor screen, touch **Pause Run**.

   The Pause Run dialog box is displayed:

   The run pauses for the duration set in the Set Time-Outs screen (see page 2-15).

   In the Pause Run dialog box:
   - Remaining Time shows the remaining time for the pause.
   - Elapsed Time is continually updated to show the time the run has been in process.

2. If you want to:
   - Pause until the default pause has elapsed – Do nothing.
   - Pause for a specific amount of time – Touch **Edit Time**, enter the duration of the pause, then touch **Done**. The run resumes when the pause is complete.
   - Resume the run immediately – Touch **Resume Run** (to the left of the dialog box).

**Stopping a Run**

In the Run Monitor screen, touch **Stop**, then **OK**.

The run stops and the Run Report opens.
Chapter 3  Performing a Run

Using the Run Monitor Button

The Run Monitor button (Figure 3-1) is displayed at the top of the Run Monitor screen. If you leave the Run Monitor screen during a run, this button also appears at the top of all menu screens.

![Figure 3-1 The Run Monitor button](image)

You can touch the Run Monitor button to return to the Run Monitor screen at any time.

If an error occurs during the run, the area showing the current stage, in the middle of the button, is replaced by an alert icon:

![Alert icon](image)

If the Power Fails

If a power failure occurs during a run, the instrument attempts to continue the run when the power returns. The run begins at the first step of the stage where the power failed.

For example, the power fails during step 2 of the tenth cycle for a stage with three steps and 20 cycles. After the power returns, the run starts at step 1 of the tenth cycle and continues for 11 more cycles.

**Note:** If the time between the initial power failure and the time the power returns is more than 18 hours, the run is not continued.
Chapter 3  Performing a Run

Viewing and Printing the Run Report

At the end of a run, the Run Report screen is displayed (below). If the last stage of the run method is an infinite hold, you must touch Stop, then OK in the message box before the Run Report is displayed.

You can also see the Run Report by touching View Last Run in the Tools Menu:

![Run Report Screen]

**Note:** The run report is saved only until the next run is finished.

- To print the run report, in the Run Report screen, touch Print.
  
  If any errors occurred during the run, the error information is also printed.
- To save the run report to the USB drive, touch Save.

Removing the Samples from the Instrument

Grasp the sample tray/retainer assembly or reaction plate firmly with both hands and gently rock it back and forth until the tubes (or plate) are free.

⚠️ **CAUTION** Sample caps may pop off if the cover is opened when the sample block(s) temperature is above 27 °C.
Troubleshooting

This chapter covers:

Troubleshooting ................................................................. 4-2
Returning an Instrument for Service ................................. 4-3
# Troubleshooting

Use the following table to help troubleshoot problems with your Veriti™ Thermal Cycler.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Causes</th>
<th>Check and/or Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cooling rate too slow</td>
<td>Peltier assembly failure</td>
<td>Run the Cycle Performance Test.</td>
</tr>
<tr>
<td>Temperature does not match specified temperature</td>
<td>Instrument may require calibration</td>
<td>Run the Temperature Verification Test.</td>
</tr>
<tr>
<td>Heating rate too slow</td>
<td>Peltier failure</td>
<td>Run the Cycle Performance Test.</td>
</tr>
<tr>
<td>Printing fails</td>
<td>Printer incorrectly configured on instrument</td>
<td>Make sure the printer IP address on the instrument matches the IP address from the system administrator.</td>
</tr>
<tr>
<td></td>
<td>Printer not connected to network</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Instrument not connected to network</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ethernet cable bad</td>
<td></td>
</tr>
<tr>
<td>Cycling time too long</td>
<td>Peltier assembly failure</td>
<td>Run the Cycle Performance Test.</td>
</tr>
<tr>
<td>When running on multiple instruments, cannot see instruments in “Select Instruments” screen</td>
<td>Instrument(s) not connected to network</td>
<td>Are all Ethernet cables connected to the instruments?</td>
</tr>
<tr>
<td></td>
<td>Switch powered off</td>
<td>Are all Ethernet cables connected to the network switch?</td>
</tr>
<tr>
<td></td>
<td>Ethernet cable bad</td>
<td>Try a different Ethernet cable.</td>
</tr>
<tr>
<td></td>
<td>IP address conflict</td>
<td>Change the IP addresses on the instruments.</td>
</tr>
<tr>
<td></td>
<td>Allow Remote Runs setting set to No.</td>
<td>In Instrument Name screen, change Allow Remote Runs to Yes.</td>
</tr>
<tr>
<td>No screen display</td>
<td>Blown fuse</td>
<td>Check fuses.</td>
</tr>
<tr>
<td>No response when you power on the instrument</td>
<td>Not connected to power source</td>
<td>Is power switch on?</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Is power cord connected?</td>
</tr>
<tr>
<td>Screen display is missing characters or is illegible</td>
<td>LCD screen failure</td>
<td>Request service</td>
</tr>
<tr>
<td>Sample tubes melt during run</td>
<td>Incompatible consumables used</td>
<td>Use recommended consumables (see Appendix B, Disposables).</td>
</tr>
<tr>
<td></td>
<td>Heated cover too hot</td>
<td>Run the Heated Cover Verification Test.</td>
</tr>
<tr>
<td></td>
<td>Sample block(s) too hot</td>
<td></td>
</tr>
<tr>
<td>Heated cover stuck</td>
<td>Cam, platen, or cover assembly malfunctioning</td>
<td>Request service</td>
</tr>
<tr>
<td>Heated cover not responsive</td>
<td>Heated cover failure</td>
<td>Run the Heated Cover Verification Test.</td>
</tr>
</tbody>
</table>

**Veriti™ Thermal Cycler User Guide**
Returning an Instrument for Service

Before returning an instrument for service, back up the run methods and instrument settings, as described in “Backing Up Run Methods and Other Settings” on page 1-13. This practice ensures that if the service center sends you a replacement instrument, you can restore the run methods and other settings.

To return an instrument for service:

1. Contact your local customer care center or technical support group to obtain a copy of the Certificate of Instrument Decontamination, a service notification, a service call number, and, if required, packaging.

2. Decontaminate the instrument.

   **IMPORTANT!** If the sample block(s) become contaminated with radioactivity, use a commercially available decontaminant to remove the contamination. If the block(s) cannot be decontaminated, the instrument cannot be returned to Applied Biosystems for service.


4. Fax the Certificate of Instrument Decontamination to the customer care center.

5. Pack the instrument in the provided packaging, without any accessories or power cords. Include a hard copy of the Certificate of Instrument Decontamination in the box.

   **Note:** Repairs for instruments without the Certificate of Instrument Decontamination are delayed.

6. Affix the provided postage to the box, then ship the instrument to the designated facility.

   The repair process requires 2 to 3 weeks.
This chapter covers:

- **Using GeneAmp® PCR System 9700 Run Methods**.......................... 5-2
- **Upgrading System Firmware**......................................................... 5-5
- **Calculating Melting Temperatures**............................................... 5-7
- **Viewing Instrument Statistics**...................................................... 5-8
- **Restoring the Factory Settings**..................................................... 5-8
- **Running the Cycle Performance Test**.......................................... 5-10
- **Tests Using the Temperature Verification Kit**............................ 5-11
Using GeneAmp® PCR System 9700 Run Methods

**Note:** This function is only available on Veriti 96-Well Thermal Cyclers.

The Veriti™ Thermal Cycler has a Convert Method tool to guide you through importing existing run methods from a GeneAmp® PCR System 9700 thermal cycler.

The tool is designed to create a method for the Veriti Thermal Cycler with ramp rates that simulate those on the 9700 thermal cycler. Although the ramp rates may be similar in the two methods, the results on the Veriti Thermal Cycler may differ from those from the GeneAmp PCR System 9700 and, therefore, additional optimization may be needed.

The available conversions are specific to the type of instrument:

- Veriti 96-Well Fast Thermal Cycler – Only 9700 Max Mode run methods can be converted.
- Veriti 96-Well Thermal Cycler – Run methods in 9600 Emulation Mode or 9700 Max Mode can be converted.

**Note:** Only users who can save run methods (all users except Limited Users) have access to this function.

**To use a run method from a GeneAmp® PCR System 9700 thermal cycler:**

1. Obtain a copy of the original method you want to convert, either by printing it from the instrument or copying it manually to a piece of paper.

2. In the Main Menu screen, touch **Tools Menu**.

3. In the Tools Menu screen, touch **Convert a Method** to open the Convert Method wizard:

4. Touch the check box next to the run method’s original format (9700 Max Mode or 9600 Emulation Mode) then touch (Next).
5. In the second page, enter the original run method. You can include AutoDelta steps, pauses, and VeriFlex™ steps, and you can edit the ramp rates:

![Diagram of Convert Method Step 2 of 2]

Touch (Next). when you are done.

6. In the Save Run Method page (below), enter a name and select a folder for the run method. Names are limited to 16 characters. By default, the name begins with “9700-Max-Mode-” or “9600-Mode-”, depending on the format selected in step 4.

Also enter the reaction volume, the temperature for the heated cover (if any), and any notes for this method.

![Diagram of Save Run Method]

When you finish, touch Save & Exit.

The Tools Menu is displayed.
Note: You cannot edit the ramp rates in the method created by the Convert Method wizard. This is indicated by “9600” or “9700M” in the Time field, when you choose to view ramp rates rather than time (see Figure 5-1).

Figure 5-1  Converted run method, showing “9700M” as the ramp rate
Upgrading System Firmware

About the Upgrade
If Applied Biosystems provides a new version of the firmware for the Veriti Thermal Cycler, you may be required to load the new firmware on the instrument.
You will need a USB drive and, if your instrument requires login, Administrator access to upgrade the firmware.

**IMPORTANT!** You cannot upgrade the firmware while a run is in progress.

Upgrading the Veriti Thermal Cycler Firmware

1. Determine the version number of the existing firmware from the About the Instrument screen.
   a. Open the About the Instrument screen:
      - Touch **Log Off** to return to the Login Options screen, then touch **About the Instrument**.
      or
      - In the Main Menu screen, touch **Settings Menu**, then **About the Instrument**.
   The About the Instrument screen opens:
   b. Record the version number of the firmware, then touch **Done**.

2. Determine the version number of the new firmware.
   a. On a computer connected to the Internet, go to [www.appliedbiosystems.com](http://www.appliedbiosystems.com).
   b. Click **Support**, then **Software Downloads**.
   c. Select **Veriti Thermal Cycler** in the list, then click **Updates & Patches**.
   d. Find the appropriate file. If the version number is:
      - The same as the current version (from step 1), you do not need to upgrade the firmware.
      - Different from the current version (from step 1), follow the steps below to download and upgrade the firmware.
3. Download the new firmware to a USB drive:
   a. Insert the USB drive into the USB port on the computer.
   b. Click the link in the Software column to download the file. Select the USB drive as the location for the saved file.
   c. Remove the USB drive from the computer when the download is complete.

To upgrade the instrument with the new firmware:

1. Follow the instructions in “Backing Up Run Methods and Other Settings” on page 1-13 to save your run methods and settings from the Veriti Thermal Cycler.
2. Insert the USB drive with the new firmware in the USB port on the front of the Veriti Thermal Cycler.
3. Log in as a user with Administrator access.
4. In the Main Menu screen, touch Settings Menu.
5. In the Settings Menu screen, touch Admin Menu.
6. In the Admin Menu screen, touch Upgrade Firmware.
   The Firmware Upgrade screen opens:

   ![Firmware Upgrade](image)

7. Touch Source File to display a list of the files on the USB drive. Veriti™ system firmware files end with “.update”.
8. Touch the name of the file with the new firmware, then touch Select.
9. Touch Upgrade, then Yes.
   When the upgrade process is complete, a message box opens.
10. Restart the instrument.
Calculating Melting Temperatures

To calculate the melting temperatures for a DNA primer pair:

1. In the Main Menu screen, touch **Tools Menu**.

2. In the Tools Menu screen, touch **Calculate Tm** to open the Tm Calculator screen:

3. Enter the required information.
   a. Touch **Salt Concentration**, then enter the salt concentration in mM.
   b. Touch **Primer Concentration**, then enter the DNA concentration in µM.
   c. Enter each primer sequence.

4. Touch **Calculate**.

The melting temperature for each primer is displayed:
Viewing Instrument Statistics

The instrument records information about how it has been used. You can view this information.

1. In the Main Menu screen, touch **Tools Menu**.
2. In the Tools Menu screen, touch **Show Statistics**.

The following statistics are shown:

- **Total Cycles for Block(s)** – The total number of cycles the instrument has performed over its lifetime.
- **Total Degrees for Block(s)** – The total degrees the blocks have climbed over their lifetime. For example, if the sample block(s) were heated from 10 degrees to 30 degrees, for 3 cycles, the total degrees would be 60. \[3 \times (30 - 10) = 60\].

3. When you finish, touch **Done** to return to the Tools Menu screen.

Restoring the Factory Settings

You can reset the instrument to the default values for all instrument settings. When you do this, the following are lost:

- All run methods except the predefined methods listed in Appendix C
- Any users and their custom folders
- The instrument name and IP address
- Any changes to time-outs, block idle temperatures, security settings, printer settings, and any shortcuts to methods or functions

1. Log in as a user with Administrator access.
2. In the Main Menu screen, touch **Settings Menu**.
3. In the Settings Menu screen, touch **Admin Menu**.
4. In the Admin Menu screen, touch **Restore Factory Settings** to open the Restore Factory Settings screen:

5. In the Restore screen, touch **Restore**. The Restore Factory Settings dialog box is displayed.

6. In the dialog box, touch:
   - **Yes** to back up run methods and other settings before restoring the default settings to the instrument. Insert a USB drive for the backup.
   - **No** to restore the default settings, without first performing a back up. Before the restore operation begins, you are prompted to confirm the restore with a second dialog box.

   **IMPORTANT!** Touching **No** erases all run methods, user accounts and other settings from the instrument.

   - **Cancel** to cancel the restore operation.

   When the restore process is complete, a message box stating “Factory settings have been restored.” opens.

7. Remove the USB drive, if present, then toggle the switch on the back of the instrument to power off.

8. Toggle the switch again to power on the instrument and restart with the factory default settings.
Running the Cycle Performance Test

Use this test to verify that the sample block(s) are heating and cooling properly and that the PCR cycling function operates properly.

**Required Materials**

The appropriate equipment for your instrument:

- Veriti 96-Well *Fast* Thermal Cycler: MicroAmp™ *Fast* Optical 96-Well Reaction Plate with Barcode (PN 4346906)
- Veriti 96-Well Thermal Cycler: MicroAmp™ Optical 96-Well Reaction Plate (PN N8010560)
- Veriti 384-Well Thermal Cycler: MicroAmp™ Optical 384-Well Reaction Plate (PN 4309849)
- Veriti 60-Well Thermal Cycler: GeneAmp® Thermal Isolation Frame (PN 4308927)

**Procedure**

This test takes 10 minutes to complete.

1. Place the reaction plate or thermal isolation frame in the instrument.
2. In the Main Menu screen, touch **Tools Menu**.
3. In the Tools Menu screen, touch **Run Cycle Performance Test**.
4. Follow the instructions on the screen to perform the test. The results are displayed at the end of the test.
5. At the end of the test, touch:
   - **Print** to print the results.
   - **Save** to save the results to the USB drive.
     The results are saved to the file CyclePEvents.txt.
6. If the test fails, repeat the procedure. Ensure that the heated cover is closed.
7. If the test fails again, contact Applied Biosystems Technical Support.
Tests Using the Temperature Verification Kit

You need the Temperature Verification Kit to perform the:
- Heated Cover Verification
- Temperature Verification
- Temperature Nonuniformity Test

About the Temperature Verification Kit

The Temperature Verification Kit consists of:
- A probe – The appropriate size for the sample wells in your instrument. The probe can be ordered separately or a part of a kit. (See page 6-6 for part numbers for the probes.)
- Digital thermometer – Model 4690 Digital thermometer with 9 V battery
- Light mineral oil
- Cotton swabs

You need the appropriate model of the Temperature Verification Kit for your Veriti Thermal Cycler, as shown below.

<table>
<thead>
<tr>
<th>Veriti Thermal Cycler Model</th>
<th>Temperature Verification Kit</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Veriti 96-Well Fast Thermal Cycler (PN 4375305), with 0.1-mL sample wells</td>
<td>0.1-mL Temperature Verification Kit</td>
<td>4373997</td>
</tr>
<tr>
<td>Veriti 96-Well Thermal Cycler (PN 4375786), with 0.2-mL sample wells</td>
<td>0.2-mL Temperature Verification Kit</td>
<td>4377669</td>
</tr>
<tr>
<td>Veriti 384-Well Thermal Cycler (PN 4388444), with 0.02-mL sample wells</td>
<td>0.02-mL Temperature Verification Kit</td>
<td>4385338</td>
</tr>
<tr>
<td>Veriti 60-Well Thermal Cycler (PN 4384638), with 0.5-mL sample wells</td>
<td>0.5-mL Temperature Verification Kit</td>
<td>4309924</td>
</tr>
</tbody>
</table>

For More Information

See the Multiprobe Temperature Verification Kit User Guide (PN 4376864).

Running the Heated Cover Verification

Use this test to verify that the heated cover is within ±3 °C of the 105 °C set point.

Required Materials

The appropriate Temperature Verification Kit for your Veriti Thermal Cycler model (see table above).

Procedure

This test takes 10 to 15 minutes to complete.

⚠️ WARNING PHYSICAL INJURY HAZARD. Hot Surface. Use care when working around the heated cover and sample block(s) to avoid being burned.
1. In the Main Menu screen, touch **Tools Menu**.

2. In the Tools Menu screen, touch **Run Heated Cover Verification**.

3. Follow the instructions on the screen to perform the test.

4. At the end of the test, touch:
   - **Print** to print the results.
   - **Save** to save the results to the USB drive.

   The results are saved to the file heatedCover.txt.

5. If the test fails, repeat the procedure. Ensure the:
   - Probe plate is in the correct location. Probe 1 should be in well A5 during this test.
   - Cables are not damaged (no nicks, cuts or crimps) and are securely seated in the digital thermometer and in the instrument.
   - Heated cover is closed.
   - Results are saved or printed.

6. If the test fails again, contact Applied Biosystems Technical Support.

**Running the Temperature Verification**

Use this test to verify that the average temperature for the sample block(s) is within ±0.25 °C of the set point temperature.

<table>
<thead>
<tr>
<th>Required Materials</th>
<th>The appropriate Temperature Verification Kit for your Veriti Thermal Cycler model (see table above).</th>
</tr>
</thead>
</table>

| Procedure          | This test takes 25 to 30 minutes to complete, but you can cancel before it is complete.         |

⚠️ **WARNING** **PHYSICAL INJURY HAZARD.** Hot Surface. Use care when working around the heated cover and sample block(s) to avoid being burned.

1. In the Main Menu screen, touch **Tools Menu**.

2. In the Tools Menu screen, touch **Run Temperature Verification**.

3. Follow the instructions on the screen to perform the test.

4. At the end of the test, touch:
   - **Print** to print the results.
   - **Save** to save the results to the USB drive.

   The results are saved to the file bcalevents.txt.

5. If the test fails, repeat the procedure. Ensure the:
   - Probe is placed in the correct wells during the test.
   - A drop of mineral oil is in each of the test wells.
   - Cables are not damaged (no nicks, cuts or crimps) and are securely seated in the digital thermometer and in the instrument.
   - Results are saved or printed.

6. If the test fails again, contact Applied Biosystems Technical Support.
Running the Temperature Nonuniformity Test

Use this test to verify that the sample well temperatures are within the threshold temperature range.

**Required Materials**
The appropriate Temperature Verification Kit for your Veriti Thermal Cycler model (see table above).

**Procedure**
This test takes 10 to 15 minutes to complete, but you can cancel before it is complete.

- **WARNING** PHYSICAL INJURY HAZARD. Hot Surface. Use care when working around the heated cover and sample block(s) to avoid being burned.

1. In the Main Menu screen, touch **Tools Menu**.
2. In the Tools Menu screen, touch **Run TNU Test**.
3. Follow the instructions on the screen to perform the test.
4. At the end of the test, touch:
   - **Print** to print the results.
   - **Save** to save the results to the USB drive.
     The results are saved to the file tnuEvents.txt.
5. If the test fails, repeat the procedure. Ensure the:
   - Cables are not damaged (no nicks, cuts or crimps) and are securely seated in the digital thermometer and in the instrument.
   - Heated cover is closed.
   - Results are saved or printed.
6. If the test fails again, contact Applied Biosystems Technical Support.

**TVK Recalibration**

Applied Biosystems recommends that your Temperature Verification Kit be recalibrated once a year.

Calibrating the thermometer and probe of the Temperature Verification Kit requires that you:

- Decontaminate the probe assembly as described below.
- Send the equipment and the completed Certificate of Instrument Decontamination to the manufacturer. See “TVK Support” on page ix.

**Decontaminating the Probe Assembly**

1. Contact your local customer care center or technical support group to obtain a copy of the Certificate of Instrument Decontamination.
2. Gently wipe the probe cones with a cotton swab that has been moistened with with a 1:10 v/v solution of 5.25% sodium hypochlorite (Chlorox bleach).
   **IMPORTANT!** Do not submerge the probe in bleach solution. Do not disassemble the probe assembly.
This chapter covers:

Scheduled Maintenance .......................................................... 6-2
As-Needed Maintenance ......................................................... 6-2
Parts List ................................................................................. 6-6
Scheduled Maintenance

Run the following tests annually:

- Cycle Performance Test – page 5-10
- Heated Cover Verification – page 5-11
- Temperature Verification – page 5-12

As-Needed Maintenance

Tests  Run the Temperature Nonuniformity Test (see page 5-13).

Cleaning the Instrument

Preparation  Before cleaning the instrument:
1. Power off the Veriti™ Thermal Cycler, then remove the power cord.
2. Allow the instrument to cool until the heated cover and sample block(s) reach room temperature.

Cleaning the Touchscreen  Clean the touchscreen with any commercially available LCD cleaning product. Be careful not to scratch the screen.

Cleaning the Sample Wells  If you use any cleaning or decontamination method, except those recommended in the manual, you risk damaging the equipment. Clean the sample wells once a month or as needed.

WARNING  Always wear protective glasses and gloves when servicing the instrument. Also, make sure you disconnect the instrument from AC line power before you begin any service procedure.

CAUTION  During instrument operation, the temperature of the heated cover can be as high as 108 °C, and the temperature of the sample block(s) can be as high as 100 °C. Before performing the procedure, keep hands away until the heated cover and sample block(s) reach room temperature.

To clean the sample wells:
1. Follow the steps in Preparation, above.
2. Open the heated cover.
3. Remove the sample tray from the sample block(s) and set it aside.
4. Use a cotton swab soaked in pure isopropanol to clean the sample wells thoroughly. Make certain that the isopropanol has evaporated completely before reloading a sample tray.
Decontaminating the Sample Wells

If the sample wells become contaminated with any biological agents, clean the wells thoroughly with a cotton swab soaked in 1:10 v/v dilution of 5.25% sodium hypochlorite (Chlorox bleach).

Use bleach solution in moderation. Applied Biosystems recommends the use of 10% bleach solution for removing contamination from the Veriti™ instrument sample block(s); excessive use of the solution, however, can corrode the sample block(s) material. To prevent damage to the sample block(s):

- Avoid applying excessive amounts of bleach solution. If possible, instead of using a squeeze bottle or soaked cloth, use an atomizer to deliver the solution to the wells of the block(s).
- After treating with bleach solution, rinse the sample block(s) thoroughly using deionized water.

Note: Removing residual bleach from the surfaces of the Veriti™ instrument using water minimizes the long-term effects of bleach treatments.

Cleaning the Heated Cover

Clean the heated cover once a month or as needed.

CAUTION During instrument operation, the temperature of the heated cover can be as high as 108 °C, and the temperature of the sample block(s) can be as high as 100 °C. Before performing the procedure, keep hands away until the heated cover and sample block(s) reach room temperature.

To clean the heated cover:

1. Follow the steps in “Preparation” on page 6-2.
2. Open the heated cover.
3. Soak a cotton swab or piece of clean cloth with pure isopropanol and gently wipe the heated platen.

WARNING CHEMICAL HAZARD. Isopropanol is a flammable liquid and vapor. Exposure may cause eye, skin, and upper respiratory tract irritation. Prolonged or repeated contact may dry skin and cause irritation. Exposure may cause central nervous system effects such as drowsiness, dizziness, and headache. Read the MSDS, and follow the handling instructions.

4. Remove any remaining isopropanol from the cover.

Note: If the platen becomes contaminated with amplified DNA, then raise the heated cover to the cleaning position, wipe the platen with a cloth or cotton swab soaked in bleach, then rinse with water.

Clean the heated platen once a month or as needed.
Decontaminating the Heated Cover

If the heated cover become contaminated with amplified DNA, raise the heated cover to the cleaning position and wipe the cover with a cloth or cotton swab soaked in 1:10 v/v dilution of 5.25% sodium hypochlorite (Chlorox bleach), then wipe the cover with a damp cloth.

Replacing Fuses

Fuse Overview

The instrument has two 10 A Type M 250 V 5 × 20 mm fuses (PN 4377690).

**WARNING** **FIRE HAZARD.** For continued protection against the risk of fire, replace fuses only with Listed and Certified fuses of the same type and rating as those currently in the instrument.

**DANGER** **ELECTRICAL HAZARD.** To protect yourself against shock hazards, use a properly wired three-terminal outlet. Do not use an adapter to a two-terminal outlet since this does not provide positive ground protection.

<table>
<thead>
<tr>
<th>Instrument Configuration*</th>
<th>Main Fuse Rating</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>All configurations</td>
<td>10 A</td>
<td>4377690</td>
</tr>
</tbody>
</table>

Acceptable AC line voltage tolerances: 100, 120, 220, 230 ±10%; 240 VAC +6%/-10%, 50/60 Hz ±1%

**Required Materials**

- Two 10 A Type M 250 V 5 × 20 mm fuses
- Fine flat-tip screwdriver

**Procedure**

1. Turn off the instrument and disconnect the power cord from the back of the instrument.

**DANGER** **ELECTRICAL SHOCK HAZARD.** Severe electrical shock, which could cause physical injury or death, can result from working on an instrument when the high voltage power supply is operating. To avoid electrical shock, disconnect the power supply to the instrument, unplug the power cord, and wait at least 1 minute before working on the instrument.
The fuses are in the power entry module:

2. Insert a small flat-tip screwdriver into the slot in the upper portion of the power entry module, and open the door.
3. Pull out the fuse compartment to inspect the two fuses in the fuse compartment:

4. Pull out the blown fuse(s) from the fuse compartment and replace with new 10 A Type M 250 V 5 × 20 mm fuses.
5. Place the fuse compartment back into the power entry module (there is only one orientation) and close the door.
6. Press the door until it locks in place.
7. Connect the instrument power cord.
## Parts List

### Table 6-1 Kits and Spares

<table>
<thead>
<tr>
<th>Part</th>
<th>PN</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Kits</strong></td>
<td></td>
</tr>
<tr>
<td>Temperature Verification Kit (0.1-mL)</td>
<td>4373997</td>
</tr>
<tr>
<td>Temperature Verification Kit (0.2-mL)</td>
<td>4377669</td>
</tr>
<tr>
<td>Temperature Verification Kit (0.02-mL)</td>
<td>4385338</td>
</tr>
<tr>
<td>Temperature Verification Kit (0.5-mL)</td>
<td>4309924</td>
</tr>
<tr>
<td><strong>Spares</strong></td>
<td></td>
</tr>
<tr>
<td>Cable, AC Power Supply</td>
<td>4374647</td>
</tr>
<tr>
<td>Cam, Left Side</td>
<td>4374274</td>
</tr>
<tr>
<td>Cam, Right Side</td>
<td>4374275</td>
</tr>
<tr>
<td>Foot, Rubber (Package of 4)</td>
<td>4375246</td>
</tr>
<tr>
<td>Fuse 10A Slo-Blo</td>
<td>4377690</td>
</tr>
<tr>
<td>Grill, Plastic Mold</td>
<td>4374178</td>
</tr>
<tr>
<td>Handle, Plastic</td>
<td>4374277</td>
</tr>
<tr>
<td>Handle, Rubber Grip</td>
<td>4374181</td>
</tr>
<tr>
<td>Heated Cover</td>
<td>4374276</td>
</tr>
<tr>
<td>Panel, Left</td>
<td>4374176</td>
</tr>
<tr>
<td>Panel, Rear (Heated Cover)</td>
<td>4374280</td>
</tr>
<tr>
<td>Panel, Right</td>
<td>4374175</td>
</tr>
<tr>
<td>Probe, Temperature Verification Kit (0.1-mL)</td>
<td>4375938</td>
</tr>
<tr>
<td>Probe, Temperature Verification Kit (0.2-mL)</td>
<td>4377670</td>
</tr>
<tr>
<td>Probe, Temperature Verification Kit (0.02-mL)</td>
<td>4308757</td>
</tr>
<tr>
<td>Probe, Temperature Verification Kit (0.5-mL)</td>
<td>4309925</td>
</tr>
</tbody>
</table>
Instrument Specifications

This appendix covers:

System Specifications .............................................................. A-2
Printer Specifications .............................................................. A-3
## System Specifications

### Physical Dimensions and Electrical Specifications

<table>
<thead>
<tr>
<th>Physical Dimensions</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>23.7 cm (9.3 in)</td>
</tr>
<tr>
<td>Height</td>
<td>24.5 cm (9.6 in)</td>
</tr>
<tr>
<td>Depth</td>
<td>48.5 cm (19.1 in)</td>
</tr>
<tr>
<td>Weight</td>
<td>10.2 kg (22.5 lbs)</td>
</tr>
</tbody>
</table>

### Electrical Specifications

<table>
<thead>
<tr>
<th>Description</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Voltage</td>
<td>100 to 240 VAC 50/60 Hz</td>
</tr>
<tr>
<td>Max Power</td>
<td>10 A</td>
</tr>
</tbody>
</table>
| AC Line Voltage Tolerances   | 100, 120, 220, 230 ±10%  
                              | 240 VAC +6%/-10%, 50/60 Hz ± 1% |

### Table 1  Power and Communication

<table>
<thead>
<tr>
<th>Port</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![800 VA power cable icon]</td>
<td>800 VA power cable</td>
</tr>
<tr>
<td>![10/100 fast Ethernet port icon]</td>
<td>10/100 fast Ethernet port for a network connection</td>
</tr>
<tr>
<td>![USB v1.0 port icon]</td>
<td>USB v1.0 port for a connection to an external USB drive</td>
</tr>
<tr>
<td>![RS232 serial communication port icon]</td>
<td>RS232 serial communication port for connecting the probe for the Temperature Verification Kit</td>
</tr>
</tbody>
</table>

### Figure A-1  Connections for power and communications on the Veriti™ Thermal Cycler
Sample
Temperature
Range
- Sample temperature range: +4 to +99.9 °C
- Temperature calibration accuracy: Traceable to National Institute of Standards and Technology (NIST)

Touchscreen
Specifications
640 × 480 pixel LCD color display with full VGA resolution.

Sample Well
Specifications

<table>
<thead>
<tr>
<th>Instrument Model</th>
<th>No. of Wells</th>
<th>Volume/Well</th>
</tr>
</thead>
<tbody>
<tr>
<td>Veriti™ 96-Well Fast Thermal Cycler (PN 4375305)</td>
<td>96</td>
<td>0.1 mL</td>
</tr>
<tr>
<td>Veriti 96-Well Thermal Cycler (PN 4375786)</td>
<td>96</td>
<td>0.2 mL</td>
</tr>
<tr>
<td>Veriti 384-Well Thermal Cycler (PN 4388444)</td>
<td>384</td>
<td>0.02 mL</td>
</tr>
<tr>
<td>Veriti 60-Well Thermal Cycler (PN 4384638)</td>
<td>60</td>
<td>0.5 mL</td>
</tr>
</tbody>
</table>

Printer Specifications

The Veriti Thermal Cycler requires a printer that:
- Has an Ethernet port
- Supports the LPD/LPR protocol (often called a “TCP/IP printer”)
This appendix covers:

Disposables ........................................ B-2
Other Supplies for Sample Handling ...................... B-4
## Disposables

### Table B-1  Disposables for the Veriti™ Thermal Cycler

<table>
<thead>
<tr>
<th>Part Description</th>
<th>96-Well (0.1-mL)</th>
<th>96-Well (0.2-mL)</th>
<th>384-Well (0.02-mL)</th>
<th>60-Well (0.5-mL)</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>96-Well Plates</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MicroAmp™ Fast 96-Well Reaction Plate (0.1 mL)</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td>4346907</td>
</tr>
<tr>
<td>MicroAmp™ Fast Optical 96-Well Reaction Plate with Barcode (0.1 mL)</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td>4346906, 4366932</td>
</tr>
<tr>
<td>MicroAmp™ Optical 96-Well Reaction Plate</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td>N8010560</td>
</tr>
<tr>
<td>MicroAmp™ Optical 96-Well Reaction Plate with Barcode</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td>4316813</td>
</tr>
<tr>
<td>MicroAmp™ Optical 96-Well Reaction Plate with Barcode and Optical Caps</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td>4306737</td>
</tr>
<tr>
<td>MicroAmp™ Optical 96-Well Reaction Plate with Barcode and Optical Adhesive Films</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td>4326659</td>
</tr>
<tr>
<td>MicroAmp™ Optical 384-Well Reaction Plate</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td>403012</td>
</tr>
<tr>
<td>MicroAmp™ Optical 384-Well Reaction Plate with Barcode</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td>4314320</td>
</tr>
<tr>
<td>MicroAmp™ Optical 384-Well Reaction Plate with Barcode and Optical Adhesive Films</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td>4309849</td>
</tr>
<tr>
<td><strong>12-Well Strips</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MicroAmp™ 12-Cap Strip</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td>N8010534</td>
</tr>
<tr>
<td>MicroAmp™ 12-Cap Strip, Assorted Colors</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td>N8011534</td>
</tr>
<tr>
<td><strong>8-Well Strips</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MicroAmp™ Fast 8-Tube Strip (0.1 mL)</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td>4358293</td>
</tr>
<tr>
<td>MicroAmp™ 8-Tube Strip (0.2 mL)</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td>N8010580</td>
</tr>
<tr>
<td>MicroAmp™ 8-Tube Strip, Assorted Colors (0.2 mL)</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td>N8010838</td>
</tr>
<tr>
<td>MicroAmp™ Optical 8-Tube Strip (0.2 mL)</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td>4316567</td>
</tr>
</tbody>
</table>
Table B-1 Disposables for the Veriti™ Thermal Cycler (continued)

<table>
<thead>
<tr>
<th>Part Description</th>
<th>96-Well (0.1-mL)</th>
<th>96-Well (0.2-mL)</th>
<th>384-Well (0.02-mL)</th>
<th>60-Well (0.5-mL)</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>MicroAmp™ 8-Cap Strip</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td>N8010535</td>
</tr>
<tr>
<td></td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td>N8011535</td>
</tr>
<tr>
<td>MicroAmp™ 8-Cap Strip, Assorted Colors</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td>N8010835</td>
</tr>
<tr>
<td>MicroAmp™ Optical 8-Cap Strip</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td>4323032</td>
</tr>
<tr>
<td><strong>Single Tubes</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MicroAmp® Fast Reaction Tube with Cap (0.1 mL)</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td>4358297</td>
</tr>
<tr>
<td>MicroAmp® Reaction Tube with Cap (0.2 mL)</td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td>N8010540</td>
</tr>
<tr>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td>N8011540</td>
</tr>
<tr>
<td>MicroAmp® Reaction Tube with Cap, Assorted Colors (0.2 mL)</td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td>N8010840</td>
</tr>
<tr>
<td>MicroAmp® Reaction Tube with Cap, Autoclaved (0.2 mL)</td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td>N8010612</td>
</tr>
<tr>
<td>MicroAmp® Reaction Tube without Cap (0.2 mL)</td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td>N8010533</td>
</tr>
<tr>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td>N8011533</td>
</tr>
<tr>
<td>MicroAmp® Reaction Tube without Cap, Assorted Colors (0.2 mL)</td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td>N8010833</td>
</tr>
<tr>
<td>MicroAmp® Optical Tube without Cap (0.2 mL)</td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td>N8010933</td>
</tr>
<tr>
<td>GeneAmp® Thin-Walled Reaction Tube with Flat Cap (0.5 mL)</td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td>N8010737</td>
</tr>
<tr>
<td>GeneAmp® Thin-Walled Reaction Tube with Domed Cap (0.5 mL)</td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td>N801537</td>
</tr>
<tr>
<td>GeneAmp® Thin-Walled Reaction Tube with Domed Cap, Autoclaved (0.5 mL)</td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td>N8010611</td>
</tr>
<tr>
<td><strong>Seals &amp; Covers</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MicroAmp™ Clear Adhesive Film</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>4306311</td>
</tr>
<tr>
<td>MicroAmp™ Optical Adhesive Film</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>4360954</td>
</tr>
<tr>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>4311971</td>
</tr>
<tr>
<td>MicroAmp™ Optical Adhesive Film Kit</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td>4313663</td>
</tr>
<tr>
<td><strong>Reaction Trays</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MicroAmp™ 96-Well Tray for VeriFlex™ Blocks</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td>4379983</td>
</tr>
<tr>
<td>MicroAmp™ 96-Well Tray/Retainer Set for Veriti™ Systems</td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td>4381850</td>
</tr>
</tbody>
</table>
Other Supplies for Sample Handling

The following parts can simplify working with your samples and the Veriti™ Thermal Cycler.

<table>
<thead>
<tr>
<th>Product</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>MicroAmp™ 96-Well Base</td>
<td>N8010531</td>
</tr>
<tr>
<td>MicroAmp™ Splash Free 96-Well Base</td>
<td>4312063</td>
</tr>
<tr>
<td>GeneAmp® Thermal Isolation Frame</td>
<td>4308927</td>
</tr>
<tr>
<td>MicroAmp™ Cap Installing Tool (Handle)</td>
<td>4330015</td>
</tr>
<tr>
<td>MicroAmp™ Multi-Removal Tool</td>
<td>4313950</td>
</tr>
<tr>
<td>MicroAmp™ Adhesive Film Applicator</td>
<td>4333183</td>
</tr>
<tr>
<td>MicroAmp™ Centrifuge Adapter</td>
<td>N8013822</td>
</tr>
</tbody>
</table>
Predefined Run Methods

This appendix covers:

Predefined Run Methods. .......................................................... C-2
Predefined Run Methods

The following run methods are supplied with the Veriti™ Thermal Cycler and are stored in the Shared folder. These run methods are based on recommended protocols from Applied Biosystems and should be considered as starting points for the different applications. Your results may vary between instrument models, so some optimization may be needed. Please note that the ramp rates of these methods are 100%.

- AmpliCycle® Seq Run Method
- AmpliTaq Gold® DNA Polymerase Run Method
- AmpliTaq Gold® Fast PCR Run Method
- BigDye® Kit Fast Run Method
- BigDye® Kit Standard Run Method
- Fast PCR Run Method
- General PCR Run Method
- LMS2 Run Method
- Time Release Run Method
- Touchdown PCR Run Method
- XL PCR Run Method

These run methods cannot be edited or deleted, but if you save them with a different name or to a different folder, you can edit them.

AmpliCycle® Seq Run Method

Use this run method to achieve clean sequence ladders from femtomole quantities of template. The cycle sequencing process and the benefits of AmpliTaq® DNA Polymerase, CS, are described in the product insert for the AmpliCycle® Sequencing Kit (PN N8080175).
AmpliTaq Gold® DNA Polymerase Run Method

Use this run method for hot-start PCR in place of labor-intensive methods such as manual hot-start or wax-bead-mediated hot-start techniques. The hot-start technique helps to minimize the formation of primer-dimers or nonspecific products, thereby increasing specificity and sensitivity of PCR. This run method specifies a pre-PCR heat step for activation of AmpliTaq Gold® DNA Polymerase.

AmpliTaq Gold® Fast PCR Run Method

Use this run method for PCR with AmpliTaq Gold® Fast PCR Master Mix, up to produce optimal yield and specificity for a 500 bp amplicon. This run method is optimized to generate template for DNA sequencing reactions and is only available on Veriti™ 96-Well Thermal Cyclers.

Note: By default, the annealing temperature is set at 62 °C. Replace this temperature with the melting temperature of the primer (see “Calculating Melting Temperatures” on page 5-7).
Chapter C  Predefined Run Methods

BigDye® Kit Fast Run Method

Use this run method for cycle sequencing of dideoxy (Sanger) terminator sequencing using ABI PRISM® BigDye® Terminator Cycle Sequence Ready Reaction Kits.

BigDye® Kit Standard Run Method

Use this run method, which consists of cycle-sequencing parameters for dideoxy (Sanger) terminator sequencing, with ABI PRISM® BigDye® Terminator Cycle Sequencing Ready Reaction Kits.

The pre-coded conditions in this run method are optimized for AmpliTaq® DNA Polymerase, FS and the cycle sequencing reagents supplied with the BigDye® Terminator kits.
Fast PCR Run Method

Use this run method for use with the GeneAmp® Fast PCR Master Mix. For more information on how to convert your standard methods to Fast methods, refer to the product literature for Fast PCR Master Mix available from www.appliedbiosystems.com.

General PCR Run Method

Use this run method for standard PCR use. This method is set as the default run method for the Veriti Thermal Cycler.
LMS2 Run Method

Use this run method for ABI PRISM® Linkage Mapping Set Version 2.5 (LMS2) thermal cycling. Linkage Mapping Set Version 2 uses over 400 fluorescently labeled PCR primer pairs for analysis of select microsatellite loci from the Génethon human linkage map.

Time Release Run Method

Use this run method for use with AmpliTaq Gold® DNA Polymerase. This method minimizes the pre-PCR activation step and adds a minimum of 10 additional cycles, allowing for slow activation of the enzyme during cycling. This provides a simple method where polymerase activity increases more slowly as product accumulates, improving specificity.
Touchdown PCR Run Method

Use this run method if the optimal annealing temperature is not known. This method incrementally decreases the annealing temperature in early cycles to maximize the yield of specific products.

XL PCR Run Method

Use this run method for amplification of 5 to 40 kb PCR products using \( rTth \) DNA Polymerase, XL and unique reaction conditions. By providing longer templates, XL PCR complements technologies for rapid, long-range PCR. More complete genes can be amplified in one reaction from known expressed sequences, allowing more introns to be spanned. You can use XL PCR to amplify the control target (a 20.8-kb product from Lambda DNA) supplied in the kit.
Index

A
About the Instrument screen 5-5
adding
  AutoDelta steps 3-13
  folders 3-9
  pauses in a run method 3-15
  stages 3-10
  steps 3-11
  users 2-10
  VeriFlex steps 3-16
Admin Menu screen 1-7
AmpliCycle run method C-2
AmpliTaq run methods C-3
appendices
  Disposables B-1
  Instrument Specifications A-1
  Predefined Run Methods C-1
Applied Biosystems
  contacting viii
  customer feedback on documentation viii
  Information Development department viii
  Technical Support viii
assumptions for using this guide vii
AutoDelta step 3-13

B
backing up
  before restoring to factory settings 5-9
  run methods and settings 1-13
Big Dye Kit run methods C-4
bold text, when to use vii

C
calibrating, temperature verification kit 5-13
CAUTION, description xii
chapters
  Getting Started 2-1
  Maintenance 6-1
  Performing a Run 3-1
  System Overview 1-1
  Troubleshooting 4-1
  Utilities 5-1
chemical safety xvi
chemical waste safety xvii
cleaning
  heated cover 6-3
  sample wells 6-2
  touchscreen 6-2
conventions
  bold text vii
  for describing menu commands vii
  IMPORTANTS! vii
  in this guide vii
  italic text vii
  Notes vii
  safety xii
  user attention words vii
creating
  folders 3-9
  run methods 3-8
  shortcuts to instrument functions 2-15
  shortcuts to run methods 1-13
  users 2-10
customer feedback, on Applied Biosystems
documents viii
Cycle Performance Test 5-10
cycles
  changing during a run 3-22
  editing in a run method 3-11

D
DANGER, description xii
date, setting current 2-8
decontaminating
  heated cover 6-4
  sample wells 6-3
  temperature verification kit 5-13
default administrator user name and password 2-10
default settings, restoring 5-8
deleting
  folders 1-16
  run methods 1-12
  shortcuts 2-16
  steps or stages 3-15
  users 2-13
Display Method Time button 3-22
Disposables appendix B-1
documentation, related viii
Index

E
elapsed time for run, viewing 3-22
electrical safety xvii
electromagnetic compatibility standards. See EMC standards
EMC standards xvii
Ethernet port A-2

F
factory settings, restoring 5-8
FAST PCR run method C-5
firmware
  upgrading 5-5
  version number 5-5
folders
  creating 3-9
  deleting 1-16
  renaming 1-16
fuses
  changing 6-4
  specification 6-4

G
General PCR run method C-5
Getting Started chapter 2-1
guest users 2-9
guidelines
  chemical safety xvi
  chemical waste disposal xvii

H
hazard icons. See safety symbols, on instruments
hazard symbols. See safety symbols, on instruments
hazards. See safety
heated cover
  cleaning 6-3
  decontaminating 6-4
  setting temperature for a run 3-18
  skipping heating during a run 3-20
  temperature when idle 2-14
  verification 5-11
Help system, accessing viii
Hot icon 3-21

I
IMPORTANT, description xii
Information Development department, contacting viii
installation category xvii
instrument operation, safety xv
instrument properties
  IP address 2-7
  name 2-8
  serial number 2-8
Instrument Specifications appendix A-1
IP address, setting 2-7
italic text, when to use vii

L
linkage mapping C-6
LMS2 run method C-6

M
Main Menu screen 1-6
Maintenance chapter 6-1
maintenance schedule 6-2
Manage Users button missing 4-3
melting temperatures, calculating 5-7
menu commands, conventions for describing vii
moving parts, safety xvii
MSDSs
  description xvi
  MSDSs, obtaining viii

N
naming the instrument 2-8

O
online Help. See Help system
overvoltage category (rating) xvii

P
part numbers
  disposable supplies B-2
  Temperature Verification Kits 6-6
  thermal cycler parts 6-6
password
  default administrator 2-10
  editing 2-13
  logging in without 2-9
Pause Run button 3-22
pausing
  before a step in run method 3-15
  default duration 2-15
  during a run 3-23
Performing a Run chapter 3-1
physical hazard safety xvii
power failure during a run 3-24
Predefined Run Methods appendix C-1
printing
  run methods 1-12
  run report 3-25
Index

test results 5-10, 5-12, 5-13
troubleshooting 4-2

R
ramp rates
9600 5-4
9700M 5-4
editing 3-12
in converted methods 5-4
viewing 1-9
recalibrating, temperature verification kit 5-13
remaining time for run, viewing 3-22
remote runs
enabling 2-8
performing 3-19
troubleshooting 4-2
renaming
folders 1-16
instrument 2-8
restarting, after a power failure 3-24
restoring
factory settings 5-8
run methods and settings 1-14
returning an instrument, instructions 4-3
RS232 serial port A-2
rTth DNA polymerase C-7
run methods
backing up 1-13
copying 1-11
creating 3-8
deleting 1-12
predefined C-1
printing 1-12
restoring 1-14
saving 3-9
scrolling to left and right 3-22
shortcuts 1-13
Run Monitor screen 3-21
run parameters
entering 3-18
viewing during a run 3-22
run report
printing 3-25
saving 3-25
viewing most recent 3-25

S
safety
before operating the instrument xv
chemical xvi
chemical waste xvii
conventions xii
electrical xvii
guidelines xvi, xvii

instrument operation xv
moving and lifting instrument xv
moving parts xvii
moving/lifting xv
physical hazard xvii
standards xvii
safety labels, on instruments xiv
safety standards xviii
safety symbols, on instruments xiii
sample block(s)
statistics 5-8
temperature when idle 2-14
sample wells
cleaning 6-2
decontaminating 6-3
specifications A-3
samples
loading 3-5
unloading 3-25
Sanger sequencing C-4
saving
run methods 3-9
run report 3-25
test results 5-10, 5-12, 5-13
serial number 2-8
serial port A-2
service, returning an instrument 4-3
Settings Menu screen 1-7
shortcuts
removing 2-16
to instrument functions 2-15
to run methods 1-13
SKIP button 3-22
stages
adding 3-10
cycling 3-10
deleting 3-15
holding 3-10
standards
EMC xvii
safety xvii
statistics, instrument 5-8
steps
adding 3-11
AutoDelta 3-13
deleting 3-15
pausing before 3-15
skipping during a run 3-22
VeriFlex 3-16
STOP button 3-22
symbols, safety xiii
System Overview chapter 1-1
Index

T
Technical Support, contacting viii
Temperature Nonuniformity Test 5-13
temperature verification kit
  contents 5-11
  decontaminating 5-13
  instructions for shipping ix
  recalibrating 5-13
  user guide 5-11
Temperature Verification Test 5-12
temperature, editing 3-12
test results files
  bcalevents.txt 5-12
  CyclePEvents.txt 5-10
  heatedCover.txt 5-12
  tnuEvents.txt 5-13
test results, saving 5-10, 5-12, 5-13
tests
  Cycle Performance 5-10
  Heated Cover Verification 5-11
  Temperature Nonuniformity 5-13
  Temperature Verification 5-12
text conventions vii
time
  editing 3-12
  elapsed for run 3-22
  remaining for run 3-22
  setting, current 2-8
Time Release run method C-6
Tools Menu screen 1-8
total cycles 5-8
total degrees for block(s) 5-8
Touchdown PCR
  description 3-13
  predefined run method C-7
touchscreen
  cleaning 6-2
training, information on viii
Troubleshooting chapter 4-1
TVK See temperature verification kit 5-11

U
upgrading firmware 5-5
USB port A-2
user attention words, described vii
users
  access levels 2-10
  adding 2-10
  changing 2-12
  default administrator user name and password 2-10
  deleting 2-13
  Manage Users button missing 4-3
Utilities chapter 5-1

V
VeriFlex Blocks, description 1-2
VeriFlex Step, creating 3-16
VeritiLink Software 2-9
version number for firmware 5-5
View Method Information button 3-22

W
WARNING, description xii

X
XL PCR run method C-7
Worldwide Sales and Support

Applied Biosystems vast distribution and service network, composed of highly trained support and applications personnel, reaches 150 countries on six continents. For sales office locations and technical support, please call our local office or refer to our Web site at www.appliedbiosystems.com.

Applied Biosystems is committed to providing the world's leading technology and information for life scientists.

Headquarters
850 Lincoln Centre Drive
Foster City, CA 94404 USA
Phone: +1 650.638.5800
Toll Free (In North America): +1 800.345.5224
Fax: +1 650.638.5884

06/2010